
TIBCO ActiveMatrix® Service Grid

Release Notes
Software Release 3.4.0 
April 2019

Document Updated: December 2019



Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

ANY SOFTWARE ITEM IDENTIFIED AS THIRD PARTY LIBRARY IS AVAILABLE UNDER
SEPARATE SOFTWARE LICENSE TERMS AND IS NOT PART OF A TIBCO PRODUCT. AS SUCH,
THESE SOFTWARE ITEMS ARE NOT COVERED BY THE TERMS OF YOUR AGREEMENT WITH
TIBCO, INCLUDING ANY TERMS CONCERNING SUPPORT, MAINTENANCE, WARRANTIES,
AND INDEMNITIES. DOWNLOAD AND USE OF THESE ITEMS IS SOLELY AT YOUR OWN
DISCRETION AND SUBJECT TO THE LICENSE TERMS APPLICABLE TO THEM. BY PROCEEDING
TO DOWNLOAD, INSTALL OR USE ANY OF THESE ITEMS, YOU ACKNOWLEDGE THE
FOREGOING DISTINCTIONS BETWEEN THESE ITEMS AND TIBCO PRODUCTS.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, Two-Second Advantage, TIB, Information Bus, ActiveMatrix, Business Studio,
Enterprise Message Service, Hawk, and Rendezvous are either registered trademarks or trademarks of
TIBCO Software Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. Please see the readme.txt file for
the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any other
documentation included with the product. To access the latest documentation, visit https://
docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO ActiveMatrix® Service Grid is available on the https://docs.tibco.com/
products/tibco-activematrix-service-grid page.

Use of the following features, installation profiles and development tools requires a TIBCO
ActiveMatrix Service Grid license:

● TIBCO ActiveMatrix Policy Director Governance, TIBCO ActiveMatrix SPM Dashboard, and TIBCO
ActiveMatrix SPM Runtime Server profiles; and

● TIBCO ActiveMatrix Service Grid development tools for Java, Webapp and Spring components.

Customers with only a TIBCO ActiveMatrix Service Bus license are not licensed to use these features,
tools or profiles.

The following documents form the documentation set:

● TIBCO ActiveMatrix Service Grid Concepts: Read this manual before reading any other manual in the
documentation set. This manual describes terminology and concepts of the platform. The other
manuals in the documentation set assume you are familiar with the information in this manual.

● TIBCO ActiveMatrix Service Grid Development Tutorials: Read this manual for a step-by-step
introduction to the process of creating, packaging, and running composites in TIBCO Business
Studio.

● TIBCO ActiveMatrix Service Grid Composite Development: Read this manual to learn how to develop
and package composites.

● TIBCO ActiveMatrix Service Grid Java Component Development: Read this manual to learn how to
configure and implement Java components.

● TIBCO ActiveMatrix Service Grid Mediation Component Development: Read this manual to learn how to
configure and implement Mediation components.

● TIBCO ActiveMatrix Service Grid Mediation API Reference: Read this manual to learn how to develop
custom Mediation tasks.

● TIBCO ActiveMatrix Service Grid Spring Component Development: Read this manual to learn how to
configure and implement Spring components.

● TIBCO ActiveMatrix Service Grid WebApp Component Development: Read this manual to learn how to
configure and implement Web Application components.

● TIBCO ActiveMatrix Service Grid REST Binding Development: Read this manual to learn how to
configure and implement REST components.

● TIBCO ActiveMatrix Service Grid Administration Tutorials: Read this manual for a step-by-step
introduction to the process of creating and starting the runtime version of the product, starting
TIBCO ActiveMatrix servers, and deploying applications to the runtime.

● TIBCO ActiveMatrix Service Grid Administration: Read this manual to learn how to manage the
runtime and deploy and manage applications.
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● TIBCO ActiveMatrix Service Grid Hawk ActiveMatrix Plug-in: Read this manual to learn about the
Hawk plug-in and its optional configurations.

● TIBCO ActiveMatrix Service Grid Policy Director Governance Custom Actions: Read this manual to learn
how you can configure and enforce policies for ActiveMatrix and external services hosted in third
party containers, using TIBCO ActiveMatrix Policy Director Governance.

● TIBCO ActiveMatrix Service Grid Service Performance Manager API Reference: Read this manual to learn
how to use the SPM APIs.

● TIBCO ActiveMatrix Service Grid Error Codes: Read this manual to know more about the error
messages and how you could use them to troubleshoot a problem.

● TIBCO ActiveMatrix Service Grid Installation and Configuration: Read this manual to learn how to
install and configure the software.

● TIBCO ActiveMatrix Service Grid Security Guidelines: Read this manual to learn more about security
guidelines and recommendations for TIBCO ActiveMatrix Service Grid.

● TIBCO ActiveMatrix Service Grid Release Notes: Read this manual for a list of new and changed
features, steps for migrating from a previous release, and lists of known issues and closed issues for
the release.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

● For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.
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New Features

The following new features have been added in the ActiveMatrix 3.4.0 release. Some of the features
were first added in ActiveMatrix 3.3.1 and have been indicated as such.

Integrated TIBCO ActiveMatrix Platform

TIBCO ActiveMatrix 3.4.0 is embedded with Policy Director Governance, which provides functionality
similar to previously standalone product TIBCO Policy Director (PD). This enables dynamic policy-
based SOA governance by allowing users to manage and enforce cross-functional requirements such as
security and compliance independent of their implementation and deployment. Policy Director
Governance can be installed as a Profile using the TIBCO ActiveMatrix Installer and can be configured
using TIBCO Configuration Tool. For details, refer to the Create TIBCO ActiveMatrix Policy Director
Governance Administrator Server section in TIBCO ActiveMatrix Service Grid Installation and
Configuration.

TIBCO Service Performance Manager server is also integrated with ActiveMatrix 3.4.0 platform and can
be installed using the ActiveMatrix 3.4.0 platform installer. For details on configuring TIBCO Service
Performance Manager using the TIBCO Configuration Tool, refer to the Configure TIBCO Service
Performance Manager Components section in TIBCO ActiveMatrix Service Grid Installation and
Configuration.

The TIBCO Service Performance Manager dashboard, that was originally part of TIBCO Service
Performance Manager server, is also a part of the ActiveMatrix platform starting ActiveMatrix 3.3.1. It
can be installed through the TIBCO ActiveMatrix Installer. A new installation profile is created to install
TIBCO Service Performance Manager dashboard separately. Using the dashboard, you can monitor
assets, view measurements, and author rules. For details, refer to the TIBCO Service Performance
Manager Dashboard section in TIBCO ActiveMatrix Service Grid Administration.

Product Upgrade

You can use the new TIBCO Configuration Tool-based approach for upgrading your existing setup to
ActiveMatrix 3.4.0, and downgrading from ActiveMatrix 3.4.0 to prior supported ActiveMatrix
versions, in a robust and seamless manner. This approach is available starting ActiveMatrix 3.3.1.

For details on what the Upgrade/Downgrade entails, refer to the Upgrade and Downgrade section in
TIBCO ActiveMatrix Service Grid Installation and Configuration.

Optimization for Large Scale Environments

In ActiveMatrix 3.4.0, there have been significant performance improvements in ActiveMatrix
Administrator GUI and backend, specifically in case of TIBCO ActiveMatrix enterprises consisting of
over 1000 Nodes. The initialization time and memory usage for Policy Director Governance Service
have also been optimized, contributing to improved startup performance for large scale setups.

The following areas were optimized for large scale setups in ActiveMatrix 3.3.1:

● Optimization in notification processing when supporting large number of Hosts and Nodes within
an enterprise

● Optimization in ActiveMatrix Administrator UI to reduce the time it takes to load

● Enhancement of ActiveMatrix Administrator CLI to include timeouts to terminate long-running CLI
tasks in large scale setups

● Optimizations in updating Notification Transport, Server Configuration, and internal HTTP
Connector Configuration

● Ability to View and Download the TRA File of a host or node using ActiveMatrix Administrator UI

● Ability to create and manage remote TIBCO Hosts
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● Ability to manage and update a Host's and Node's JVM arguments using ActiveMatrix
Administrator UI and CLI

● Optimization in Hawk ActiveMatrix Plugin to reduce the memory usage

In ActiveMatrix 3.3.1, the Infrastructure > Hosts screen included a drop down for machine names. The
drop down is optimized to additionally lists the hosts by installation state (Not Installed) or by machine
name.

Assessing the Health of Applications

Starting ActiveMatrix 3.3.1, you can assess the health of applications in terms of their back-end services
and shared resource instances. The health check request is invoked on a service endpoint. The status of
the participating services, references, and shared resources is returned in a response.

Health check includes:

● Status reporting for failure scenarios (for example: health check not supported, EMS connectivity
Issues, and so on.)

● Health check timeout at global and granular level
● Caching health check response for SOAP/HTTP and SOAP/JMS endpoints
● Custom health check operation via annotations: ActiveMatrix also supports creation of annotated

health check methods for Java implementation type, which can be executed during a health check
Invocation to provide a customized health check response.

● Ability to ping SOAP/HTTP and SOAP/JMS endpoints
● Health check specific logging.

Health check can be invoked on ActiveMatrix applications (and application chains) comprising
following component types:

● Binding Types (BTs): SOAP/HTTP, SOAP/JMS (for SOAP Versions 1.1 and 1.2)
● Implementation Types (ITs): TIBCO ActiveMatrix® BPM, Java, Mediation, and Spring. Note that

only ProcessFlow components from BPM applications are applicable for health check.
● Shared Resources (RTs): JDBC, JMS Connection/Destination

In ActiveMatrix 3.4.0, the service health check feature comes with a new graphical user interface (GUI)
that can be accessed conveniently from ActiveMatrix Administrator UI. The support is extended to
REST Binding Type (BT) endpoints (including the support for caching and ping functionality).

For both SOAP and REST endpoints, service health check "ping" operation is also available over HTTP
GET in addition to HTTP POST, making the invocation more lightweight.

ActiveMatrix 3.4.0 onwards, service health check is enabled by default.

For details, refer to the Service Health Check section in TIBCO ActiveMatrix Service Grid Administration.

Enterprise Deployment Health Check

TIBCO ActiveMatrix 3.3.1 supports Enterprise Deployment Health Check to help you assess the overall
health of an enterprise, with a focus on ActiveMatrix Administrator. With this feature, you can gather
comprehensive metadata and runtime configuration information of the ActiveMatrix Administrator at
various levels (to include hosts, nodes, environments), carry out realtime test deployments, and review
all the collected information in a comprehensive report, to better equip yourself in making decisions
about substantial upcoming deployments.

ActiveMatrix 3.4.0 provides a new graphical user interface to invoke an Enterprise Deployment Health
Check, and encompasses all the health check operations.

For details, refer to the Enterprise Deployment Health Check section in TIBCO ActiveMatrix Service Grid
Administration.
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OSGi Diagnostics Check

Using the new UI-based OSGi diagnostic tool introduced in ActiveMatrix 3.4.0, you can inspect
ActiveMatrix enterprise from the perspective of diagnosing and troubleshooting failures related to
interdependencies between various runtime entities, right from the Administrator UI. It provides an
easy-to-use interface for accessing OSGi information which is typically hidden behind complex console
commands, the outcome of which is difficult to parse.

For details, refer to the OSGi Diagnostic Tool section in TIBCO ActiveMatrix Service Grid Administration.

Monitoring Enterprise Status

Starting ActiveMatrix 3.3.1, using ActiveMatrix Administrator, you can check the status of all
ActiveMatrix entities (nodes, hosts, applications, and resource instances, and the enterprise) from a
single page. To access this page, open ActiveMatrix Administrator UI and navigate to Infrastructure >
Enterprise Status.

For details, refer to the Monitoring the Status of Entities from a Single Page section in TIBCO
ActiveMatrix Service Grid Administration.

Enterprise Search

Starting ActiveMatrix 3.4.0, ActiveMatrix Administrator comes with a built-in search functionality. This
functionality can be used to search various entities in the ActiveMatrix enterprise based on their name,
type, runtime state and other parameters, and also carry out certain context-specific actions on the
searched entities. For details, refer to the Searching for Entities in an Enterprise section in TIBCO
ActiveMatrix Service Grid Administration.

Synchronizing Node Feature List

Using the 3.4.0 ActiveMatrix Administrator CLI you can synchronize the node Feature list displayed in
ActiveMatrix Administrator UI (Navigate to Infrastructure > Nodes > Configuration > Features tab or
Infrastructure > Software Management > Features > View By Nodes tab to view) with the runtime
node's feature list (Run the tibcohost shell command describeEnabledProductFeatures to view), in
the event that the lists are out of sync. This is usually a result of using the tibcohost command for
enabling or disabling features on the runtime node. For details, refer to the Synchronizing node Feature
List section in TIBCO ActiveMatrix Service Grid Administration.

Removing Dependency on Messaging Bus

If the applications you intend to run in the ActiveMatrix enterprise are never virtualized, that is, never
distributed across multiple nodes, then the messaging bus connectivity for the nodes and the
virtualization queues created as a result, pose an unnecessary overhead and need for housekeeping.
Starting ActiveMatrix 3.4.0, you can create enterprises that do not use the underlying messaging bus.
All the environments in such an enterprise, and the nodes under them, consequently do not use the
messaging bus either.

You may also choose to create an enterprise that uses the messaging bus, but contains one or more
environments (and subsequently nodes) that do not use messaging bus. If messaging bus, or
virtualization is not used by a node, environment or enterprise, certain restrictions apply, for example,
you cannot distribute applications in an enterprise or environment that does not use messaging bus.
Certain policies that rely on the messaging bus, such as "Virtualize", do not work as expected.

For information during installation and configuration stage, refer to the Create TIBCO ActiveMatrix
Administrator Server section in TIBCO ActiveMatrix Installation and Configuration.

For information during administration stage, refer to the respective sub-sections in the Managing
Environments, Managing Nodes and Managing Applications sections of TIBCO ActiveMatrix Service
Grid Administration.
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Viewing policies applied to an Application

Starting ActiveMatrix 3.4.0, in the "Policy Set" pane of the application in ActiveMatrix Administrator
UI, you can view the policies applied to the application from TIBCO Business Studio, both embedded
and inline. Policies can be viewed at the application sub-components' levels by expanding the
application in the left pane. For details, refer to the Viewing Policies Applied to an Application section
in TIBCO ActiveMatrix Service Grid Administration.

Downloading Logs of Administrator Entities

Using ActiveMatrix 3.4.0 Administrator UI and CLI you can download all the logs related to an
application as an aggregated archive that combines logs from the nodes on which the application is
deployed, the hosts managing those nodes, and SystemNode. The viewaction.html page is also part
of the archive, and displays all the user actions associated with the application.

For details, refer to the Downloading Logs for an Application section in TIBCO ActiveMatrix Service Grid
Administration.

Using the Enterprise Status page (In the ActiveMatrix Administrator UI, navigate to Infrastructure >
Enterprise Status), you can also download logs, thread dumps and TRA files of hosts and nodes within
the enterprise. Logs for applications can also be downloaded. Starting ActiveMatrix 3.3.1 , you can
download the TRA file of a host or node from the Host tab and Node tab of the Enterprise Status page.

For details, refer to the Host Tab, Node Tab and Application Tab sub-sections in the Monitoring the
Status of Entities from a Single Page section in TIBCO ActiveMatrix Service Grid Administration.

Support for REST Binding Type in TIBCO ActiveMatrix

Starting ActiveMatrix 3.3.1, REST binding type is fully integrated in TIBCO ActiveMatrix, that is, REST
bindings can be added in TIBCO Business Studio and deployed in TIBCO ActiveMatrix Administrator
without any additional changes at the time of product installation.

In ActiveMatrix 3.4.0, REST binding type support is extended to Administrator Command Line
Interface (CLI) as well as GUI. With this, REST service bindings can be added in ActiveMatrix
Administrator. Additionally, ActiveMatrix Administrator also supports the execution of service health
check for REST bindings, including caching and ping.

For details, refer to the Service Health Check in TIBCO ActiveMatrix Service Grid Administration.

HTTP-based policies, such as Basic Authentication for REST service bindings, and Basic Credential
Mapping for REST reference bindings are also supported starting ActiveMatrix 3.4.0.

REST bindings can also be monitored via the TIBCO Service Performance Manager dashboard.

To make accessing ActiveMatrix REST Services easier, Swagger support is introduced for REST BT via
ActiveMatrix Administrator UI as well as TIBCO Business Studio starting ActiveMatrix 3.4.0. For
details, refer to the REST Bindings section in TIBCO ActiveMatrix Service Grid Administration, and the 
Generating a Swagger JSON File from TIBCO Business Studio section in TIBCO ActiveMatrix Service
Grid REST Binding Development.

Validating JDBC Resource Template Configuration

ActiveMatrix 3.4.0 Runtime Platform provides the option to validate the configuration of JDBC resource
templates and corresponding resource instances by performing a test connection on the resource while
it is being installed. This way, if the configuration is incorrect, for example, wrong credentials are
specified, then the Resource Instance installation fails, thus giving you an opportunity to update the
configuration and not waiting until there is a business failure at invocation time. The validation can be
disabled if required. For details, refer to the Disabling Test Connection to a JDBC Resource section in
TIBCO ActiveMatrix Service Grid Administration.
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Jetty Upgrade

In ActiveMatrix 3.3.1, the Jetty version for HTTP Connector resource templates is upgraded from 6.1.26
to 9.2.15. The Servlet version (javax.servlet) is upgraded from 2.0 to 3.1.

In ActiveMatrix 3.4.0, the Jetty version is further upgraded to 9.2.25. The Servlet version
(javax.servlet) remains 3.1.

For details, refer to the Configuring and Preparing HTTP Connector for Jetty 9 section in TIBCO
ActiveMatrix Service Grid Administration.

Support for Single Sign-on (SSO) using OpenID Connect

ActiveMatrix 3.4.0 supports Single Sign-on (SSO) using OpenID Connect with JSON Web Tokens (JWT)
for WebApp Implementation Type (IT) and REST Binding Type (BT) endpoints. This is supported with
the use of OpenID Authentication policy set and underlying "OpenIDAuthentication" resource
template, thus streamlining its usage for a single Application, or group of Applications to participate in
SSO.

For details, refer to the Single Sign-On to SOA Applications using OpenID Connect section in TIBCO
ActiveMatrix Service Grid Administration.

Support for Single Sign-on (SSO) using SAML SSO Web Profile

SSO can also be orchestrated in ActiveMatrix 3.4.0 using Security Assertion Markup Language (SAML)
SSO Web Profile, with SAML 2.0, for WebApp Implementation Type (IT) endpoints. This includes the
support for encryption and signing in accordance with the SAML 2.0 SSO Web Profile. This is also
enforced with the use of SAML SSO Web Profile Authentication Policy.

For details, refer to the Single Sign-On to SOA Applications using SAML SSO Web Profile section in
TIBCO ActiveMatrix Service Grid Administration.

Assessing Node Health

ActiveMatrix 3.4.0 introduces the notion of aggregated node health, comprising the cumulative status
of the entities, such as application fragments, deployed on the node and synchronization status of the
node. This aggregated status can deem the node as Healthy, indicating that none of the entities
deployed on the node have failed, or Not Healthy, when one or more entities are in failed state. Node
health may also be marked as In Progress and Unknown depending on the status of the entities.

It can be accessed via GUI as well as Command Line Interface (CLI), and can be used to troubleshoot
failures. For details, refer to the Viewing an Aggregated Status of a Node section in TIBCO ActiveMatrix
Service Grid Administration.

"Read-only" and "suspended" modes for ActiveMatrix Enterprise

ActiveMatrix 3.4.0 provides you the option to put your ActiveMatrix setup in "read-only" mode, that is,
none of the user actions you carry out have any effect on the state of the enterprise. All "write"
operations, such as creating or deleting a node, are blocked.

ActiveMatrix 3.4.0 also provides the option to suspend an enterprise in order to take a backup before
planned upgrades, no longer requiring to shut it down, thus avoiding disruptions in business
continuity. The "suspended" mode restricts all user actions that can alter the state of the enterprise, such
as application deployment or upgrade, ensuring that storage entities, namely the backend database and
file system, are in a synchronized state, effectively resulting in a consistent backup. Once the backup is
complete, the suspended actions resume as expected.

For details, refer to the Suspending or Unsuspending an Enterprise section in TIBCO ActiveMatrix
Service Grid Administration.

11

TIBCO ActiveMatrix® Service Grid Release Notes

https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-564B76CF-B67B-4FE2-8BDF-626F69C6DDD8.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-D91D888F-2266-4019-9A87-E52C6333BB33.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-1E583367-BE63-4D40-A4C8-3E0B66AF5D32.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-771605EA-E50D-4E9F-A4C5-7CA3DC7CD1D7.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-8D957571-CC75-40E2-8EAA-FD5245D61090.html


New TIBCO Business Studio Version

In ActiveMatrix 3.3.1, TIBCO Business Studio is upgraded to support Eclipse 4.4.1.

In ActiveMatrix 3.4.0, TIBCO Business Studio is further upgraded to support Eclipse 4.7.1a. For details
about Eclipse Oxygen 4.7.1.a, see https://projects.eclipse.org/releases/oxygen.

On Linux, the minimum version of GTK required is 2.24.0.

For details, refer to the Using TIBCO Business Studio section in TIBCO ActiveMatrix Service Grid
Installation and Configuration.

Swagger Support for REST Service Bindings

ActiveMatrix 3.4.0 TIBCO Business Studio also provides support for generating Swagger specification
for REST Service Bindings. The specification can be used in any Swagger client to invoke ActiveMatrix
REST Services.

For details, refer to the Generating a Swagger JSON File from TIBCO Business Studio section in TIBCO
ActiveMatrix Service Grid REST Binding Development.

Reference Injection for WebApp IT Components

TIBCO Business Studio provides the option to inject References into WebApp Implementation Type (IT)
component implementations of the Web Application Resource or Archive (WAR) type. To achieve this,
you need to enable this feature from the Studio Preferences as it is disabled by default, and carry out
some additional steps when creating the WAR which are used for the component implementation,
pertaining to @Reference annotations. For details, refer to the Enabling a Reference Injection section in
TIBCO ActiveMatrix Service Grid Web Application Component Development.

Updating existing Third-party JDBC Drivers

Existing JDBC Drivers can be upgraded in the resource template of an ActiveMatrix node using TIBCO
ActiveMatrix 3.4.0 Administrator Command Line Interface (CLI). The new JDBC Drivers need to be
configured using the "Configure Third-Party Driver" wizard of the TIBCO Configuration Tool before
upgrade. For details, refer to the Upgrading a Third-party JDBC Driver using the CLI section in TIBCO
ActiveMatrix Service Grid Administration.

Support for the following JDBC Driver versions is added to ActiveMatrix 3.4.0:

● Oracle 12C R2 JDBC Driver 12.2.0

● DB2 11 JDBC Driver 4.24.92

● Microsoft SQL Server JDBC Driver 7.0.0

Updated Ant Version

The Ant version used internally by ActiveMatrix 3.4.0 is updated to 1.9.9. Ant is used to launch the
"Administrator CLI Script Generation" wizard from TIBCO Business Studio, the TIBCO Configuration
Tool, and Enterprise Deployment Health Check.

Updated Tomcat® Version

TIBCO ActiveMatrix 3.4.0 supports Apache Tomcat® version 7.0.82. The Tomcat server used by the
TIBCO Service Performance Manager dashboard has been upgraded from 7.0.77 to 7.0.90.

The following features are available starting ActiveMatrix 3.3.1:
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Host Manager

Starting ActiveMatrix 3.3.1, TIBCO Host Manager offers new commands to manage TIBCO Runtime
Hosts and Nodes in large scale Enterprises. The commands allow the user to start and stop Hosts, and
the Nodes managed by them, in various modes.

For details, refer to the Host Manager section in TIBCO ActiveMatrix Service Grid Installation and
Configuration.

Host Lifecycle Management

Starting ActiveMatrix 3.3.1, TIBCO ActiveMatrix Administrator allows lifecycle management of TIBCO
host instances on remote machines via Administrator. This includes the ability to create, edit, install,
start, stop, uninstall and delete TIBCO host instances.

To use this lifecycle management, you need at least one pre-created TIBCO host instance on a remote
machine that is registered with TIBCO ActiveMatrix Administrator (done via TIBCO Configuration
Tool). Then, using this instance, TIBCO ActiveMatrix Administrator can create additional TIBCO host
instances on the remote machine and can perform lifecycle operations.

For details, refer to the Managing Hosts section in TIBCO ActiveMatrix Service Grid Administration.

Exporting and Importing Configuration Data

Starting ActiveMatrix 3.31, you can export and import configuration data from TIBCO ActiveMatrix
Administrator using Administrator.

You can export ActiveMatrix objects such as environments, nodes, applications, and resource templates
to CLI scripts. The CLI scripts can be modified as needed and then executed using ANT on the same or
a different ActiveMatrix enterprise. This recreates the objects based on the exported archive. You can
export data using the ActiveMatrix Administrator UI (by navigating to Administrator Configuration >
Admin Server > General tab and clicking Export Wizard) or using the ActiveMatrix Administrator CLI
with the provided Ant task. For details, refer to the Export and Import section in TIBCO ActiveMatrix
Service Grid Administration.

Copying PFU (Preparing for Undeploy) Components across BPM Nodes

Typically when the TIBCO ActiveMatrix BPM user adds a new BPM node to existing BPM setup, the
existing BPM applications are redistributed to the newly added BPM node, due to the symmetric nature
of BPM applications. The components of the BPM applications that are in the 'Preparing For Undeploy
(PFU)' state, however, are not automatically redistributed.

TIBCO ActiveMatrix 3.3.1 provides a simplified ActiveMatrix Administrator CLI-based solution using
which components in the 'Preparing For Undeploy (PFU)' state can be redistributed in a single,
automatic step. The BPM users still have to perform the prerequisite steps of creating the new BPM
node type and mapping the amx.bpm.app application to the newly created BPM node. For details, refer
to the Copying Preparing for Undeploy (PFU) Components across BPM Nodes section in TIBCO
ActiveMatrix Service Grid Administration.

Restarting a Host or Node

For large deployments, you might need to change the configuration of a host or node frequently and
then restart the host or node to make sure the changes are reflected in the ActiveMatrix Administrator.
Starting ActiveMatrix 3.3.1, you can restart a host or node using the ActiveMatrix Administrator GUI or
CLI and easily apply all the changes related to the host or node. For details, refer to the Restarting a
TIBCO Host and Restarting a node sections in TIBCO ActiveMatrix Service Grid Administration.

13

TIBCO ActiveMatrix® Service Grid Release Notes

https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-51D5732E-34E3-46E9-8CDC-569E6D5160F9.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-BB94DCA3-B146-482B-8AC2-55158A481F7F.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-770EFCDE-9685-4D33-974A-2B03E5908C76.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-5881F4B9-53F4-4E76-A5C4-D38F319A02DD.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-0B564444-4B83-4A91-8163-7965D2837477.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-0B564444-4B83-4A91-8163-7965D2837477.html
https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-D224270B-3B46-440F-AC43-14BDDC81324C.html


Updating the JVM Configuration of a Host and Node

You can modify JVM and all user-specific Java properties for hosts and nodes using the ActiveMatrix
3.3.1 Administrator UI or CLI. For details, refer to the Updating the JVM Configuration of a Host
section in TIBCO ActiveMatrix Service Grid Administration.

Editing the Notification Transport Server Configuration

ActiveMatrix 3.3.1 provides a more stable approach for updating the Notification Transport Server
Configuration, especially when updating large scale setups. At present, this approach is available only
through the ActiveMatrix Administrator CLI.

For details, refer to the Editing the Notification Transport Server Configuration using the CLI section in
TIBCO ActiveMatrix Service Grid Administration.

Updating Internal HTTP Connector Configuration

The ActiveMatrix 3.3.1 Administrator CLI provides a more stable approach for updating an internal
HTTP connector, particularly for a large scale setup. For details, refer to the Updating Internal HTTP
Connector Configuration section in TIBCO ActiveMatrix Service Grid Administration.

Reconnecting to the Notification Server

You can reconnect to the Notification Transport server using ActiveMatrix 3.3.1 Administrator UI and
CLI. Reconnecting to the Notification Server involves recreating all the connections from ActiveMatrix
Administrator to the Notification Server and refreshes the status of all entities.

This feature can be used to fix inconsistent status of ActiveMatrix Administrator and Runtime, and lost
status of task execution. For details, refer to the Reconnecting to EMS section in TIBCO ActiveMatrix
Service Grid Administration.

Viewing and Managing DAA Files

In TIBCO ActiveMatrix 3.3.1 Administrator, a new tab under Infrastructure > Software Management
enables you to view and manage DAA files. In addition, you can also download DAA files. These
capabilities are available through the ActiveMatrix Administrator GUI as well as CLI.

Uninstalling Features using Wildcards

Using the TIBCO ActiveMatrix 3.3.1 Administrator CLI, you can uninstall (mark for uninstall) or
disable a feature from a node by specifying the version as a wildcard (*). For example, specifying a
version of 1.0.* uninstalls (marks for uninstall) all features whose version starts with 1.0.

List of Plugins in Software Management Feature Tab

A list of plugins for each feature version is listed in the Feature List. You can see the plugin list under
Infrastructure > Software Management > Features tab in TIBCO ActiveMatrix 3.3.1 Administrator UI.

Date Display for Features

The date display for node features listed in Feature List for each node in TIBCO ActiveMatrix 3.3.1
Administrator UI under Infrastructure > Nodes > Configuration > Feature tab has changed. New
columns (Modified On, Modified By, Deployed On, and Deployed By) have been added to the Node >
Configuration > Features screen.

Appending the Host Name to the Executable Process

TIBCO ActiveMatrix 3.3.1 Administrator allows appending of the TIBCO host instance name to the
tibcohost executable process. For details, refer to the Monitoring the Status of Entities from a Single
Page section in TIBCO ActiveMatrix Service Grid Administration.
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Creating Multiple Nodes with the Same Name

TIBCO ActiveMatrix 3.3.1 Administrator allows creation of two or more nodes with the same name on
a single TIBCO host instance, where the Nodes belong to different environments. For details, refer to
the Creating Multiple Nodes with the Same Name section in TIBCO ActiveMatrix Service Grid
Administration.

Emitting 'Sender Identifier' Information

For SOAP service endpoints, TIBCO ActiveMatrix 3.3.1 emits a field from each SOAP request that
identifies the sender of the request to TIBCO Service Performance Manager. This "Sender Identifier"
field helps TIBCO Service Performance Manager gather statistics based on the 'Sender' of the request,
for instance, the number of requests the endpoint has received from a particular sender. This feature is
supported for SOAP/HTTP and SOAP/JMS endpoints, for SOAP versions 1.1 and 1.2.

For details, refer to the Emitting 'Sender Identifier' Information section in TIBCO ActiveMatrix Service
Grid Administration.

Schema Validation for SOAP Messages

In ActiveMatrix 3.3.1 you can validate both incoming and outgoing SOAP messages against the WSDL
schema at the SOAP binding level itself before continuing on to other ActiveMatrix components. This
feature can be enabled from TIBCO Business Studio as well as ActiveMatrix Administrator and is
supported for SOAP/HTTP and SOAP/JMS service and reference bindings, for SOAP versions 1.1 and
1.2.

For details, refer to the Schema Validation for SOAP Messages section in TIBCO ActiveMatrix Service
Grid Administration.

SOAP Headers for Declared Faults

SOAP Headers can be defined for Declared Faults, using "Message" context parameters in TIBCO
Business Studio starting ActiveMatrix 3.3.1. The message parts corresponding to the context parameters
are mapped to SOAP Headers at runtime in case of declared faults, similar to request and response.

Compression Support for SOAP and REST Binding Types

ActiveMatrix 3.3.1 provides compression support for request and response messages for SOAP/HTTP
and REST/HTTP binding types.

"Stand By" State of HTTP Connector

The behavior of HTTP Connector is enhanced in ActiveMatrix 3.3.1 to work better with an external
HTTP load balancer. An HTTP Connector stops listening to client connections when there are no
service endpoints or applications available to serve the requests. In other words, if all the applications
using an HTTP Connector are stopped (or undeployed), the HTTP Connector also stops. For this case,
an external HTTP load balancer can detect the unavailability of the endpoint, mark it as offline, and
stop routing requests to it. When applications are started, the HTTP connector automatically starts
listening on its port, such that the external HTTP load balancer can detect the endpoint as online and
start routing requests to it. The 'Stand By' state for HTTP Connectors represents the stopped state.

Upon installation, an HTTP Connector appears in the 'Stand By' state. When the first Application using
the HTTP Connector starts up, the HTTP Connector changes the state to the 'Running' state. When the
last Application using the HTTP Connector is stopped, the HTTP Connector goes back to the 'Stand By'
state.

For details, refer to the Runtime States section in TIBCO ActiveMatrix Service Grid Administration.
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Specifying the Maximum Pool Size

In TIBCO ActiveMatrix 3.3.1 Administrator UI, Maximum Pool Size can be specified for a JMS
Connection Factory Resource Template. The new field is available when creating a new JMS Connection
Factory Resource Template. The value of Maximum Pool Size can also be updated for existing JMS
Connection Factory Resource Templates.

Updating Threading Policy Timeout

Starting ActiveMatrix 3.3.1, you can update Threading Policy timeout values during or after
deployment time using Administrator. The timeout values must be specified in milliseconds.

Properties can be changed directly through the ActiveMatrix Administrator UI or by setting them in the
node's TRA file for the node on which the application is deployed. For details, refer to the Threading
Policy section in TIBCO ActiveMatrix Service Grid Administration.

Support for "Never Virtualize" Policy

ActiveMatrix 3.3.1 provides the "Never Virtualize" policy, which applies to Service and Reference
Virtualization Bindings (BT) and ensures that the messaging bus is never used for delivering messages.
For "Never Virtualize" policy to be applied, the communicating entities must always be on the same
node. Any policy that relies on the use of the messaging bus, for example, "At Least Once" policy and
"Transacted One Way" policy, cannot be applied in conjunction with "Never Virtualize" policy.

Graceful node Shutdown

Starting ActiveMatrix 3.3.1, when a shutdown operation is executed on a TIBCO ActiveMatrix Runtime
node, the node stops gracefully. Nodes can be shutdown gracefully from the ActiveMatrix
Administrator UI or CLI. For details, refer to the Graceful Node Shutdown section in TIBCO
ActiveMatrix Service Grid Administration.

Stopping of Nodes Configured for Manual Setup

Prior to ActiveMatrix 3.3.1, when a host was stopped, all nodes managed by that host were stopped
irrespective of their startup mode, that is, Nodes configured for manual startup were also stopped. To
prevent the stopping of Nodes configured for manual startup, a new TRA property
com.tibco.amx.decouple.Manual.Nodes is introduced in ActiveMatrix 3.3.1.

This property is used during host startup and shutdown to determine the behavior of the Nodes
configured for manual startup. As a result, the lifecycle of these Nodes is decoupled from the host
lifecycle, and as a result, the nodes do not get affected when the host is stopped/started, and their
shutdown/startup can be handled manually.

Other TIBCO Business Studio Enhancements

You can find out the version of TIBCO Business Studio using which a project was created. This
information is stored in a hidden .version file which is added to the SOA and Java implementation
project folders. This file contains important information about the project, such as timestamp, Studio
version, and Eclipse Platform version of creation or modification.

When the user generates the Administrator CLI script for a DAA using the new Studio, a new attribute
called propertyType is added to each <Property> element in the <projectName>.deployment-
config.xml file starting ActiveMatrix 3.3.1.

TIBCO Business Studio also supports adding of features by extending the Target Platform. As a result,
the Debugger can provision features from the extended Target Platform. A Target Platform can be
added or modified using the Windows > Preferences > Plug-in Development > Target Platform page.
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Java 8 Support for TIBCO ActiveMatrix Runtime and TIBCO Business Studio

Starting TIBCO ActiveMatrix 3.3.1, Java 8 is supported out-of-the-box for both the Runtime, and TIBCO
Business Studio. In case of TIBCO Business Studio, users can import existing projects (created using
TIBCO Business Studio in prior versions of ActiveMatrix) into the new TIBCO Business Studio, and
update them to use Java 8 language features.

For details, refer to the Using TIBCO Business Studio section in TIBCO ActiveMatrix Service Grid
Installation and Configuration.

TIBCO ActiveMatrix Updater Tool for Java Runtime Environment (JRE)

The TIBCO ActiveMatrix Updater Tool for Java Runtime Environment (JRE), that was originally
available as a separate installer, is available as a part of the TIBCO ActiveMatrix installation starting
TIBCO ActiveMatrix 3.3.1. The tool can be used to update the JRE version of the ActiveMatrix
environment.

For details, refer to the Updating JRE Version section in TIBCO ActiveMatrix Service Grid Installation and
Configuration.

Support for SQL Server 2017

TIBCO ActiveMatrix Service Grid now supports SQL Server 2017 AlwaysON Availability Groups with
JDBC 7.0.0.

Support for Db2 11

TIBCO ActiveMatrix Service Grid now supports Db2 11. The driver version supported is 4.24.92.

Support for PostgreSQL (Starting with TIBCO ActiveMatrix Hotfix 002)

TIBCO ActiveMatrix Service Grid now supports PostgreSQL versions 11.5 and 10.7 using JDBC driver
42.2.8. (postgresql-42.2.8.jar).

Support for Oracle Database Server 18c and 19c (Starting with TIBCO ActiveMatrix Hotfix 002)

TIBCO ActiveMatrix Service Grid now supports Oracle Database Server 18c and 19c using respective
drivers.

Support for Oracle Database Server 12c with Transparent Application Failover (TAF) (Starting
with TIBCO ActiveMatrix Hotfix 002)

TIBCO ActiveMatrix Service Grid now supports Oracle Database Server 12c with Transparent
Application Failover (TAF) using Oracle 12C R2 JDBC Driver 12.2.0. This is certified for TIBCO
ActiveMatrix runtime only. There is no TIBCO Configuration Tool (TCT) support. Contact TIBCO
Support for enabling Oracle OCI driver with TAF feature.
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Changes in Functionality

The following are changes in functionality in this release.

ADMIN-HOME Property in the CLI Scripts
You must now update the following property in all existing CLI scripts to point to the correct version
of ActiveMatrix Administrator:
<property name="ADMIN-HOME" value="<path to ActiveMatrix Administrator>"/>

Some actions, such as uploading DAA, might fail if the ADMIN-HOME property points to an older
version of the ActiveMatrix Administrator. For example, if the ADMIN-HOME property is set to
ActiveMatrix Administrator 3.3.0 in the CLI script, uploading and deploying applications on
ActiveMatrix Administrator 3.4.0 might fail.

Dependency on JRE implementations for Java XML APIs
Starting with this release, for Java XML APIs, the ActiveMatrix platform code now depends on
implementations provided by the underlying JRE instead of depending on vendor-specific
implementations. You must, however, continue to add the javax.xml packages of the user
application as the packages are not available directly in an OSGi environment.
For the Java and Spring implementation types,  add the javax.xml packages to the META-INF/
MANIFEST.MF file. For details on the procedure, refer to the TIBCO ActiveMatrix® Service Grid Java
Component Development Guide.
For the Web Application implementation type,  add the javax.xml package to the .requirements file.
For details on the procedure, refer to the TIBCO ActiveMatrix® Service Grid WebApp Component
Development Guide
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Deprecated and Removed Features

Following features have been deprecated or removed in this release.

Metrics Collection Runtime (MCR) Functionality
The Metrics Collection Runtime (MCR) functionality has been deprecated. All MCR-specific pages,
widgets, and check boxes that appeared when configuring ActiveMatrix Administrator using the
TIBCO Configuration Tool have been removed.

ActiveMatrix Administrator Dashboard

The TIBCO ActiveMatrix Administrator dashboard (Dashboards > Infrastructure) has been
deprecated.

You can check the status of all ActiveMatrix entities (nodes, hosts, applications, and resource
instances) from the Infrastructure > Enterprise Status page. From this page, you can also search for
entities in an Enterprise and perform specific actions on them.

Publishing to UDDI Server
The ability to publish Application Services to Universal Description, Discovery and Integration
(UDDI) Server using TIBCO ActiveMatrix Administrator has been deprecated.
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Migration and Compatibility

For instructions on how to migrate from a previous release to the current release, refer to the
ActiveMatrix Service Grid Installation and Configuration Guide.

Product Compatibility

TIBCO ActiveMatrix 3.4.0 is compatible with the following product versions:

● TIBCO Enterprise Message Service™ 8.5.1 (Starting with TIBCO ActiveMatrix Hotfix 002)

● TIBCO Hawk® 6.1.0

Support for Spring Security Release

The Spring version supported by TIBCO ActiveMatrix Service Grid has been upgraded from 2.5.6 to
Spring security release 2.5.6.Sec03.
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Closed Issues

The table lists closed issues in this release.

Key Summary

AMRP-5676 In TIBCO ActiveMatrix BPM setup, when the Java property
com.tibco.amx.cf.enable.virtualizationAddress.versioning was set to
true for the BPMNode, a NullPointerException was seen in the Node logs when
an operation was invoked immediately following the undeployment and
redeployment of the user's BPM Application, or after BPMNode restart. This
issue is specific to ActiveMatrix BPM environments and has now been addressed.

AMRP-5615 While updating JVM arguments from TIBCO ActiveMatrix Administrator GUI or
CLI, the order of JVM arguments was not maintained, duplicate JVM arguments
were allowed and JVM arguments in different units were not allowed. With this
fix, all above issues have been addressed.

AMRP-5601 For any authentication request, by default, the ActiveMatrix platform allowed
HTTP GET method requests. There was no way to disable the HTTP GET method
requests.

Now, you can control the URI names for which HTTP GET method can be
disabled for authentication requests. This can be controlled by using the Java
property, com.tibco.governance.authentication.disable.get.URI.

The Java property can be set in the node's TRA file or the ActiveMatrix
Administrator UI as follows.

● Node's TRA file

In the runtime node's TRA file, set the property
com.tibco.governance.authentication.disable.get.URI to comma-
separated URI names for which HTTP GET method is disabled. A * at the end
of a URI indicates that the URI names that start with the pattern mentioned in
the property are disabled. The following example implies URI names starting
with abc or xyz are disabled.
com.tibco.governance.authentication.disable.get.URI=/
abc,abc/,/xyz/*

● ActiveMatrix Administrator UI

Set the property using the ActiveMatrix Administrator UI via Infrastructure >
Nodes > Select Node > Configuration > JVM Configuration.

— Property: com.tibco.governance.authentication.disable.get.URI

— Value: comma-separated URI names
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AMRP-5585 If TibcoHost was installed as a Windows service on a Windows machine, it failed
intermittently while uninstalling the host and the following error was displayed:
TIBCO-AMX-INFRA-002114: Unable to rename the node's directory 
<TIBCO_CONFIG_HOME>\tibcohost\<TH_INSTANCE_FOLDER>\data_3.2.x\host
\plugins to <TIBCO_CONFIG_HOME>\tibcohost\<TH_INSTANCE_FOLDER>
\data_3.2.x\host\plugins.tmp0 before deletion

This error is specific to the Microsoft Windows operating system and is a result of
the file locking mechanism in Microsoft Windows operating system. To address
this, in case a file or folder lock is detected in the file system, ActiveMatrix
Administrator now retries to uninstall the host up to 10 times with a delay of 1
second between tries.

AMRP-5579,

AMX-16047
Using the new UI-based OSGi diagnostic tool introduced in ActiveMatrix 3.4.0,
you can inspect ActiveMatrix enterprise from the perspective of diagnosing and
troubleshooting failures related to interdependencies between various runtime
entities, right from the ActiveMatrix Administrator UI. It provides an easy-to-use
interface for accessing OSGi information which is typically hidden behind
complex console commands, the outcome of which is difficult to parse.

For details, refer to the OSGi Diagnostic Tool section in TIBCO ActiveMatrix
Service Grid Administration.

AMRP-5558 When the TIBCO ActiveMatrix Runtime processes the commands issued by the
Administrator (RDA), a file lock issue occurred as a result of the file management
system on Windows OS. This resulted in indefinite wait while executing
Administrator CLI. With this fix, the Runtime layer is now able to send
appropriate error notifications about the failure back to Administrator, so that the
Administrator can process the failure and the CLI process can be terminated in a
timely manner.

AMRP-5556 In a TIBCO ActiveMatrix setup, if a copy of a node folder existed under the
<TIBCO_CONFIG_HOME>/tibcohost/<TH_INSTANCE_FOLDER>/data_3.2.x/

nodes, tibcohost commands such as describeNodes incorrectly considered the
copied node folder as a valid node artifact during processing.

This resulted in unused or corrupt data within the copied node folder being read,
with various errors showing up in the logs. For example: 
TIBCO-AMX-HPA-000270: there is no process associated with node 
<Copied Node Folder Name> 

With this fix, a node folder is considered for processing only if a node-to-JMX
connection mapping is found for the node name. Stray folders are not considered
as valid node artifacts.

AMRP-5555 In a TIBCO ActiveMatrix environment, if a plugin jar is corrupted, the
provisioning of the Features containing the corrupted jar as member bundles
would fail without providing any information about the corrupted jar. The
exception message printed in the logs, which was too generic, has now been
fixed. The exception message now provides the exact details of the jar file. For
example:
TIBCO-AMX-INFRA-000262: Error calculating checksum for file /apps/
tibco/components/shared/1.0.0/plugins/test_1.1.1.001.jar 
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AMRP-5545 When applications that use HTTP Client resource template were deployed and
invoked by sending multiple requests, the output of the TibcoHost
describeDeployedResourcePools command always returned 0 for 'Pool
allocated size' and 'Pool active size'. Also, 'Pool maximum size' always displayed
the default Maximum Pool size value (20). As a result, it was not possible to
determine the number of active connections catering to the requests and total
connections kept alive in the connection pool.

This issue has now been fixed. Now, when connection pooling is used, the
execution of the tibcohost describeDeployedResourcePools command
returns the correct values for 'Pool maximum size' (value of maximum total
connections), 'Pool allocated size' (number of connections kept alive) and 'Pool
active size' (number of connections currently catering to the requests).

When connection pooling is not used, the execution of the tibcohost
describeDeployedResourcePools command returns Zero (0) for 'Pool
maximum size', 'Pool allocated size' and 'Pool active size'. As connection pooling
is not used, monitoring connection pool statistics is not required.

AMRP-5542 In case of TIBCO ActiveMatrix SOA projects containing Java Implementation
Type (IT) or Spring Implementation Type (IT) configured with a JAXB Data
Binding, if the Port Type(s) used by the Java IT or Spring IT Component were
defined using multiple complex WSDLs, the underlying JAXB layer had memory
management issues, such as object references not being removed from the
memory, resulting in no garbage collection. This lead to high memory usage at
runtime. These issues have now been fixed and high memory usage is no longer
seen.
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AMRP-5537 In TIBCO ActiveMatrix BPM, a process can be updated by adding a new
operation to the WSDL. For process instances created and started for newer
versions of such applications, request messages accumulated in the internal
messaging queue and the following error message was seen in the BPM node
logs: 

org.osoa.sca.ServiceRuntimeException: TIBCO-AMX-CF-010002: Missing

target for operation

With this fix, if the Java property
com.tibco.amx.cf.enable.virtualizationAddress.versioning is set to
true on the BPM node, the error message is no longer shown and process
instances of the new version of the application are successfully created, started
and processed as expected.

If the Java property is not specified, the default value is false. The Java property
can be set in the node's TRA file or the ActiveMatrix Administrator UI as follows.

● Node's TRA file

Set the property
com.tibco.amx.cf.enable.virtualizationAddress.versioning to true
in the runtime node's TRA file as follows:
java.property.com.tibco.amx.cf.enable.virtualizationAddress.ver
sioning=true

● ActiveMatrix Administrator UI

Set the property using the ActiveMatrix Administrator UI via Infrastructure >
Nodes > Select Node > Configuration > JVM Configuration.

— Property:
com.tibco.amx.cf.enable.virtualizationAddress.versioning

— Value: true

AMRP-5517 Due to a bug in Teneo third-party library, the Teneo Session Factory did not
honor the JPA annotation for Hibernate ID Generator. This issue has now been
fixed.

AMRP-5510 As part of this enhancement, the SSO_ID cookie is now secured when HTTP
Connector resource template is configured with SSL.
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AMRP-5463 Server Name Indication (SNI) is now supported and enabled by default in the
HTTP Client resource template.

To disable the support, set the Java property in the node's TRA file or the
ActiveMatrix Administrator UI as follows.

● Node's TRA file

Set the property com.tibco.amf.httpclient.disableSNI to true in the
runtime node's TRA file as follows.
java.property.com.tibco.amf.httpclient.disableSNI=true

● ActiveMatrix Administrator UI

Set the property using the ActiveMatrix Administrator UI via Infrastructure >
Nodes > Select Node > Configuration > JVM Configuration.

— Property: com.tibco.amf.httpclient.disableSNI

— Value: true

AMRP-5207 Running the tibcohost spawn command with the -clearCache option resulted
in the following error:
Error reading tibcohost.tra file. TIBCO-AMX-HPA-CLI-000141: The 
tibcohost process failed to start. OS exit code 0. Try calling 
the tibcohost executable directly with the argument --debug to 
collect more information. Verify the location and accessibility 
of the JVM library in error. 

With this fix, the tibcohost spawn command works with the -clearCache
option as expected. The command successfully spawns the TibcoHost in the
background even when the -clearCache option is used.

AMSG-9686 Using Administrator CLI you can now synchronize the Node Feature list
displayed in Administrator UI with the Runtime Node's Feature list, in the event
that the lists are out of sync. This is usually a result of using the tibcohost
command for enabling or disabling Features on the Runtime Node. For details,
refer to the Synchronizing Node Feature List section in TIBCO ActiveMatrix
Service Grid Administration.

AMX-17074,

AMX-16595,

AMX-16253

ActiveMatrix 3.4.0 now supports now supports Oracle 12c R2. The driver version
supported is 12.2.0.

AMX-16914 The Ant version used internally by ActiveMatrix 3.4.0 has been updated to 1.9.9.
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AMX-16647,

DSS-985

With JRE 1.8 update 172, TIBCO ActiveMatrix TibcoHost failed to start with
following error:
java.security.UnrecoverableKeyException: Rejected by the 
jceks.key.serialFilter or jdk.serialFilter property

This failure is now addressed with the addition of the property
jceks.key.serialFilter. If the property is added to end of
<TIBCO_HOME>/amx/3.3/scripts/rpflauncher_classpath_3.3.0.tra for all
the <TIBCO_HOME>s within the enterprise as follows, the error is no longer seen.
java.property.jceks.key.serialFilter=com.tibco.**;java.lang.Enum;j
ava.security.KeyRep;java.security.KeyRep
$Type;javax.crypto.spec.SecretKeySpec;!*

The same property must be added to the end of <TIBCO_HOME>/tct/1.4/
TIBCOConfigurationTool.ini when TIBCO Configuration Tool (TCT)) is
involved, that is:
-
Djceks.key.serialFilter=com.tibco.**;java.lang.Enum;java.security.
KeyRep;java.security.KeyRep$Type;javax.crypto.spec.SecretKeySpec;!
*

AMX-16264 TIBCO ActiveMatrix now supports invocation of Administrator web service via
standalone JAX-WS client.

AMX-16227 The classloading issues related to using common context for WebApp
Implementation Type (IT) are now addressed.

AMX-16226 TIBCO Business Studio provides the option to inject References into WebApp
Implementation Type (IT) component implementations of the Web Application
Resource or Archive (WAR) type. To achieve this, you need to enable this feature
from the Studio Preferences as it is disabled by default, and carry out some
additional steps when creating the WAR which will be used for the component
implementation, pertaining to @Reference annotations. For details, refer to the 
Enabling a Reference Injection section in TIBCO ActiveMatrix Service Grid Web
Application Component Development.

AMX-16093 During an upgrade, the upgrade script stopped and failed to upgrade hosts when
it encountered the error "Source resource does not exist". This has now
been resolved and the upgrade to 3.4.0 succeeds as expected.

AMX-16091 Upgrading the setup from 3.1.5 to 3.3.0 to 3.4.0 version was not supported. This is
now supported.

AMX-15841 After upgrading to ActiveMatrix 3.4.0, the amx_jre_updater discover
command did not work as expected.

This issue is now fixed. When the amx_jre_updater discover command is run
from <TIBCO-Home>/amx/3.4/bin, it returns the JRE location correctly.
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AMX-15292 Accented French characters were not displayed correctly in the TIBCO
ActiveMatrix BPM workspace, which resulted in incorrect output. This issue
occurred only when the com.tibco.amx.messageflow logger level was set to
DEBUG or TRACE.

With this fix, the correct characters are displayed in the BPM workspace (BPM
Inbox, task submission section, and so on) irrespective of the logger level.

AMX-14619 The tibcohost describeDeployedConnectors command has been enhanced to
include threadpool statistics in addition to the HTTP Connector information.

To execute the command:
<CONFIG_HOME>\tibcohost\Admin-amxadmin-instanceOne\host
\bin>tibcohost.exe describeDeployedConnectors -nodeName SystemNode

BJMS-1575 When a JMS Message was sent to an ActiveMatrix application containing a
Promoted Service with JMS Binding Type (BT) configured with In-Only
operations, a NullPointerException was seen in the logs. Moreover, no fault
response was returned as the issue arises only for In-Only operations, that is,
operations with no reply.

With this fix, the NullPointerException is no longer seen and the message
processing is carried out by the configured Implementation Type (IT) as expected.

As a workaround for this issue, it was advised to manually set the
"Error Action" for JMS Binding to "Retain Message in Service
Destination" via TIBCO Business Studio, and then rebuild the DAA.
This workaround resulted in consequent errors. With the above fix, no
other issues occur and workarounds are not required for end-to-end
message processing.

DSS-975 In TIBCO ActiveMatrix Administrator, the HTTP Client resource template could
not be configured to connect to an HTTPS server that supported only TLSv1.2.
The Configure SSL wizard failed to connect to the HTTPS URL to get the
certificates.

With this fix, you can configure the HTTP Client resource template with an SSL
Client Provider that supports TLSv1.2 protocol.

Additionally, an HTTPS Connector supporting TLSv1.2 protocol can be created
from ActiveMatrix Administrator UI or CLI by configuring the SSL Server
Provider property, SSL Protocol=TLSv1.2. Even though the TLSv1.2 option is
not available in the Administrator UI drop-down list, you can manually type in
"TLSv1.2" in the value field.

HKAM-340 When monitoring a TibcoHost created through the CLI in TIBCO Hawk
ActiveMatrix Plug-in for TIBCO Hawk (HKAM), the host restarted automatically
when the CLI stop command was executed for TibcoHost. This issue is now
fixed.

HKAM-335 For the getComponentInfo and getBindingInfo methods, the History section in
a subscribed window was not updated with the new binding status.

This issue is now fixed and the History section is updated according to the
application and binding state.
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HKAM-327 In TIBCO Hawk ActiveMatrix Plug-in, when you changed the node state from
the ActiveMatrix Administrator, the History section did not get updated with
new rows and new values in the subscribed window.

This issue is now fixed and the History section is now being updated for specified
time intervals. Additionally, state changes are shown correctly with every update.

MED-3350,

EMPR-164

When certain TIBCO Business Studio projects containing Mediation Transform
tasks created in TIBCO Business Studio 3.6.0 (corresponding with TIBCO
ActiveMatrix 3.2.0) were imported in TIBCO Business Studio 3.6.1
(corresponding with TIBCO ActiveMatrix 3.3.0), and if you clicked on the Input
tab of the Transform task, the following error message was displayed:
Runtime Exception...See Error log for stack.

No details were recorded in the error Log of TIBCO Business Studio. Even when
the JRE incompatibility issues were fixed using "Quick Fix", the
NullPointerException (NPE) persisted when you clicked on the Input tab of the
Transform task. This issue is now fixed and neither errors are seen with imported
projects.

PD-4363 In large scale ActiveMatrix enterprise setups with TIBCO Policy Director
Governance (PD) 1.1.0, it was observed that while restarting the ActiveMatrix
SystemNode, the PD Governance Service was taking close to an hour to initialize.
This was observed on a setup spanning over 250 hosts that managed an upward
of 800 nodes and hosted more than 1500 applications. The database queries
related to initialization were taking very long to execute and the TEMP table
space usage grew close to 5 GB during the time.

The database queries have now been optimized to filter out unwanted
Governance Objects (GO), and with this fix, the initialization time for Governance
Service has now significantly reduced along with the TEMP table space usage. As
a result, the SystemNode restart time has reduced and is now within a reasonable
range for an enterprise of this size.

PD-4307 If ActiveMatrix Administrator was configured with TIBCO Policy Director
Governance, removing an application from an Object Group did not remove the
Governance Control on the application, especially if there was another
application on the same node that had the same Governance Control. As a result
of the Governance Control still being present, the policy was still being
incorrectly enforced on the removed application, resulting in erroneous behavior.

With this fix, the underlying database entries are now correctly updated for the
removed application and the policy is not enforced on the removed application.

PD-4292 In TIBCO ActiveMatrix Administrator, when you select Governance for an
application, the governance control status was displayed. It did not display the
activation status of a governance control. Starting with 3.4.0, you can see the
Activation Status of a governance control as Active or Inactive.

PD-4286 In ActiveMatrix Administrator, when you click Governance > Governance
Controls, it was not possible to view the list of all the target objects with
governance control status.

You can view the list of all the objects with governance control status now by
clicking the Open In New Window button.
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PD-4284 ActiveMatrix Administrator did not display the deployment progress of
Governance Control in the GUI.

This issue is now fixed. You can see the deployment status in TIBCO
ActiveMatrix Administrator by selecting Governance > Governance Control.

● When Governance Control is in the deploying, undeploying, or deployed
state, it shows number of successful, failed, in progress and total members. It
is hidden when the Governance Control is in the draft or undeployed state.

● It is seen as per deployment for Activated and Deactivated governance
control.

PD-4283 In a TIBCO ActiveMatrix environment with TIBCO ActiveMatrix Policy Director
1.1.0, on the Governance Controls page in Policy Director UI, objects could not be
sorted based on the column fields (Object, Deployed on Service Container, and
status). For example, if a Governance Control had more than 1000 targets and the
deployment failed on some of these targets, the only way to identify the targets
on which the deployment had failed was to manually scroll through the entire
list, which is time-consuming in a large scale setup.

With this fix, the objects on the Governance Controls page can now be sorted
based on the column fields (Object, Deployed on Service Container, and status).

PD-4282,

PD-4338
There have been significant performance improvements in Administrator GUI
and backend, specifically in case of TIBCO ActiveMatrix enterprises consisting of
over 1000 Nodes. The initialization time and memory usage for Policy Director
Governance Service has also been optimized, contributing to improved startup
performance for large scale setups.

PD-4271 After applying TIBCO ActiveMatrix 3.3.0 Hotfix 019, the "GC overhead limit
exceeded" error was seen on SystemNode if either:

● TIBCO Policy Director Governance, or

● the System application "com.tibco.amx.mcr.aggregator", or

● both

were part of the TIBCO ActiveMatrix Administrator configuration.

The error was caused by a memory leak which has now been fixed, and the "GC
overhead limit exceeded" error is no longer seen on well-tuned setups.

PD-4261 If TIBCO ActiveMatrix Administrator was configured with TIBCO Policy
Director Governance, when a dynamic Object Group was created and the initial
list of members was added to the Object Group, it was observed that after an
unknown duration of time, any new members that match the criteria of the
Object Group were not being added to the existing or newly created Object
Group(s). This was because the internal Governed Object cache did not get
updated for the newly deployed application due to the SQL error ORA-01795:
maximum number of expressions in a list is 1000. The Object Group
members are calculated based on this Governed Object cache.

With this fix, the issue is no longer seen and the expected members that match
the criteria are seen in the Object Group. Above SQL error is also no longer seen.
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PD-4253 When TIBCO ActiveMatrix Administrator was started in a large-scale enterprise
that contained TIBCO Policy Director Governance, some of the deployed
applications did not show up in the Governed Object groups. This occurred
because the initialization of some Governance-related services failed with a
java.lang.StackOverflowError exception.

This has now been fixed and the exception is no longer seen during TIBCO
ActiveMatrix Administrator startup.

PD-4250 When creating a proxy application from a concrete WSDL that contains
<soap:header> elements in <wsdl:input> and <wsdl:output> messages in
addition to <soap:body>, message context parameters are created for each
<soap:header> to map the messages. In case a <wsdl:input> or <wsdl:output>
message contained multiple headers referring to the same message as shown
below, duplicate message context parameters were being generated in the proxy
application's composite.
<wsdl:output>
    <soap:body parts="bodyPart" use="literal"/>
    <soap:header message="tns:headerMessage" part="header1" 
use="literal"/>
    <soap:header message="tns:headerMessage" part="header2" 
use="literal"/>
</wsdl:output>

As seen in above example, both <soap:header> elements point to the same
<message> "tns:headerMessage". This resulted in a failure to process the
<soap:header> at runtime, which in turn caused the proxy application to not
propagate the headers received from the external service back to the invoking
client.

With this fix, the message context parameters generated for the proxy application
are unique, thus addressing the issue of missing Headers.

PD-4187 If TIBCO ActiveMatrix Administrator was configured with TIBCO Policy
Director Governance, if the user ran the Sync utility located at <TIBCO_HOME>/
administrator/3.3/scripts/governance/util/sync (executing delete and
sync actions for Governed Objects), the Governed Objects of type "AgentInstance"
were not being synchronized for Platform applications
com.tibco.amx.platform of each of the runtime nodes after the sync action.
This was due to the fact that the utility iterated over all the level 1 application
folders (such as "System"), and that the platform application is by default inside
the application folder System/amx.platform.apps, that is, level 2. This resulted
in policy deployment failure with the error: Failed to resolve agent
instance.

With this fix in ActiveMatrix Administrator, when you run the Sync utility, the
data of all ActiveMatrix Administrator entities gets collected by recursively
traversing all application folder levels, thus synchronizing the "AgentInstance"
Governed Objects for platform applications.
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PER-2176 TIBCO ActiveMatrix BPM users were unable to log on to TIBCO ActiveMatrix
BPM Openspace/Workspace if the setup contained a node which was created
with the same name as a previously force-uninstalled and force-deleted node.
This issue occurred because the post-uninstall database cleanup was not being
carried out by Administrator in case of force option.

With this fix, the database entries associated with the particular node are cleaned
up as expected, and users can successfully log on to the setup.

PER-2172 When ActiveMatrix Administrator tried to install a Resource Instance (RI) with
dependency on non-existant Resource Instance(s), the underlying policy
enforcement layer tried to synchronize all entities in Administrator. This is
unnecessary, and impacts the performance when it comes to large scale setups
containing thousands of entities. This issue has now been addressed.

RSBT-656,

RSBT-654

When deploying a service with a REST Reference Binding, a
NullPointerException occurred. In a DAA file containing a REST Reference
Binding, if the REST Resource Configuration (RRC) file corresponding to the
Binding contains an Error (Declared Fault) definition which does not specify the
HTTP status code, it resulted in deployment failure (NullPointerException).

In ActiveMatrix Administrator. specifying HTTP status code is mandatory for
error definitions. Therefore, this fix addresses the NullPointerException by
providing a more meaningful exception.
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RSBT-641 In a scenario where Mediation Implementation Type component was wired to a
REST Binding Type Reference, and the Reference Binding received a fault
message from an external service, the HTTP Status Code for which was not
specified in the REST Resource Configuration (RRC) file, the exchange became
unresponsive and the requesting client did not receive any response.

With this enhancement, the fault handling for REST Reference Bindings has been
improved to handle faults that are not listed in the RRC file. For example, if the
RRC file contains error entries for HTTP status codes 401 and 402 respectively,
and the REST Reference Binding receives a fault with HTTP status code 404, the
fault is propagated to the Mediation Implementation Type and subsequently, the
requesting client (depending on the Mediation Implementation Type).

At least one declared fault (error with valid HTTP status code) must be
specified in the RRC file to achieve the expected behavior.

To enable this enhancement, set the Java property
com.tibco.amf.runtime.bindingtype.rest.enableExtendedUndeclaredFau

ltSupport to true in the runtime node. The default value of this property is
false.

The Java property can be set in the node's TRA file or the ActiveMatrix
Administrator UI as follows.

● Node's TRA file

Set the property
java.property.com.tibco.amf.runtime.bindingtype.rest.enableExte

ndedUndeclaredFaultSupport to true in the runtime node's TRA file as
follows:
java.property.com.tibco.amf.runtime.bindingtype.rest.enableExte
ndedUndeclaredFaultSupport=true

● ActiveMatrix Administrator UI

Set the property using the ActiveMatrix Administrator UI via Infrastructure >
Nodes > Select Node > Configuration > JVM Configuration.

— Property:
com.tibco.amf.runtime.bindingtype.rest.enableExtendedUndecla

redFaultSupport

— Value: true

SDS-7745 In TIBCO Business Studio, NullPointerException was seen during the 'Deploy
Project' workflow when 'Offline Server' was selected in the 'Administrator
Connection Configuration' tab.

With this fix, no error is seen and deployment scripts are generated without any
error.
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SDS-7742 As part of the Java Implementation Type code regeneration in TIBCO Business
Studio, XML bean and interface jars are generated for all the data types and
PortTypes defined in the WSDL and XSD files used in the SOA projects. When
migrating SOA projects from TIBCO ActiveMatrix Service Grid 2.3 to
ActiveMatrix 3.4.0 Studio, the Java IT implementation is regenerated to comply
with the 3.4.0 best practices.

If the WSDLs used by the SOA projects contain XSD files that in turn import
other XSD files and so on, NullPointerException errors were seen during code
generation for some of the Java ITs. These errors are a result of optimizations that
were introduced in TIBCO ActiveMatrix 3.2.0 to promote reuse of XML beans
across the XSD files in order to reduce the size of the implementation.

To address this problem, a property has been introduced to disable the reuse of
beans across XSD files and avoid missing dependency issues with certain WSDL
and XSD files as seen in the reported issue.

With this, XML beans are generated for each XSD and the data types it contains,
and there is no reuse across XSDs for common data types.

To enable this fix, add the com.tibco.amx.disable.reuse.jars.for.schema
property to the <TIBCO_HOME>/studio/5.0/eclipse/configuration/
config.ini file and set it to true as follows: 
com.tibco.amx.disable.reuse.jars.for.schema=true

Restart the TIBCO Business Studio with a clean flag as follows:
<TIBCO_HOME>/studio/5.0/eclipse/TIBCOBusinessStudio.exe -clear

Clean the workspace and the SOA projects in TIBCO Business Studio using the
Project > Clean dialog.

SDS-7709 If javax.xml.soap.MessageFactory was used for creating a SOAP Message in
the Java Implementation Type of an ActiveMatrix Composite, execution failed
with the following error:
javax.xml.soap.SOAPException: Unable to create message factory 
for SOAP: Provider 
com.sun.xml.messaging.saaj.soap.ver1_1.SOAPMessageFactory1_1Impl 
not found

The failure was seen in the TIBCO Business Studio Rapid Application
Development (RAD) environment as well as with runtime nodes. This issue has
now been fixed.

As a part of the fix, the Business Studio user must add an import-package for the
javax.xml.soap package (version "5.0.0") in the META-INF\MANIFEST.MF of the
Java Implementation Type Plugin project, as follows:
Import-Package: javax.xml.soap;version="5.0.0"     

SDS-7690 In TIBCO Business Studio, accessing the Help > Help Contents page resulted in
an HTTP 500 error. This happened because of the following known issue in
Eclipse: https://bugs.eclipse.org/bugs/show_bug.cgi?id=442310.

This issue is now fixed.
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SDS-7632 When you generate an ActiveMatrix Administrator CLI script from a DAA file,
you can now see a new attribute propertyType in the <Property> element of the
<projectName>.deployment-config.xml file.

Before the fix, the <Property> element appeared as follows:
<Property name="Component1_Property1" value="NewJDBCResource" 
xsi:type="amxdata:Property”/>

With this fix, the propertyType attribute is added to the <Property> element as
follows:
<Property name="Component1_Property1" 
propertyType="JdbcDataSource" value="NewJDBCResource" 
xsi:type="amxdata:Property"/>

SDS-7626 In ActiveMatrix 3.3.1, TIBCO Business Studio used Java 8 as JRE. In Java 8, access
to external schema is restricted. This issue is now resolved.

SDS-7624 In ActiveMatrix 3.3.1 when an application was tested with the Web Service
Explorer by using "Debug in RAD", it returned an "HTTP 500" error. This
happened because of the following known issue in Eclipse:

https://bugs.eclipse.org/bugs/show_bug.cgi?id=442310

This issue is now resolved.

SDS-7438 The daaloc parameter of the sds.generateDeploymentScript script did not
accept an absolute path. Paths had to be provided relative to the workspace. With
this fix, the daaLoc parameter accepts an absolute path so that the DAA file can
be kept in any folder instead of a workspace project folder.

TAP-15699 When you successfully logged on to the ActiveMatrix Administrator and the
logger com.tibco.amx.login was set to level WARN, the SystemNode log
showed a spurious and incorrect WARN message of failed authentication. When
logger com.tibco.amx.login was set to INFO level, no message was printed to
indicate successful authentication.

This issue has now been fixed by introducing a check for authentication status
before printing log messages of any level. With this fix, a failure message is
printed only if there is an authentication failure when logging on to ActiveMatrix
Administrator.

TAP-15685 For TIBCO ActiveMatrix host and node, the user was able to delete the root
logger configuration which resulted in incorrect logger configuration in runtime.

With this fix, the root logger cannot be deleted and the exception Not allowed
to delete Root Logger is thrown when the user attempts to delete the root
logger.
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Key Summary

TAP-15673 When an application is deleted in ActiveMatrix Administrator, the application's
DAA is not deleted by default along with it, even if no other application uses the
DAA. A new cleanupDAA option is now introduced for the attribute options of
the Delete Application target. When deleting the application with options set to
cleanupDAA, the DAA is removed if the application being deleted is the only one
using the DAA.Starting ActiveMatrix 3.4.0, setting the options attribute of the
AMXAdminTask of the Delete Application target to cleanupDAA, removes the DAA
if the application being deleted is the only one using the DAA. This is executed as
a part of the Delete Application task.The cleanupDAA option can be set in the
Delete Application <AMXAdminTask> as follows:
<target name="delete.app">
<AMXAdminTask
remote="true"
propsFile="${basedir}/remote_props.properties"
action="delete"
dataFile="${basedir}/cli_data.xml"
objectSelector="Environment//Application"
overwrite="true"
merge="true"
createIfNotExists="true"
options="cleanupDAA"
force="true"
failOnError="true"/>
</target>

For information about delete and other actions to manage applications, refer to
TIBCO_HOME\administrator\3.4\samples\application_build.xml.

35

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

TAP-15660 The installation of JDBC resource instances in ActiveMatrix Administrator UI
completed successfully even if the configuration of the underlying JDBC resource
template was invalid. For instance, if the specified database credentials or
connection URL were invalid, the problem was not caught at the time of resource
instance installation but only when the resource instance was actually used by
the parent application, thus causing potential business impact in production.

With this enhancement, the underlying runtime layer validates the database
configuration parameters at the time of resource instance installation by
performing a test connection. If the parameters are incorrect, the resource
instance installation fails. This error propagates back to the user via ActiveMatrix
Administrator thus giving you an opportunity to correct the configuration before
it causes business disruption. To disable this enhancement at a resource template
level, set the disableValidateConnectionOnInit attribute to true in the JDBC
resource template configuration via ActiveMatrix Administrator CLI as follows:
<ResourceTemplate name="JDBCResourceTemplate1"     
description="JDBC Resource Template"     
maxConnections="8888"     
sslJNDIName=""     
disableValidateConnectionOnInit="true"     
xsi:type="typ:JdbcResourceTemplate"     
xmlns:type="http://tibco.com/amxadministrator/command/line/
types">    
<TargetScope type="Enterprise"/>        
    <Direct 
dbUrl="jdbc:oracle:thin:@dbhostname:1521:orcl"         
     isTransactional="false"         
     jdbcDriver="oracle.jdbc.OracleDriver"         
     loginTimeOut="2"/>        
     <InlineCredentials username="baduser" password=****/>
</ResourceTemplate> 

The default value of this attribute is false. To disable this enhancement for all
resource templates, set the property
com.tibco.admin.jdbc.disable.validate.connection.oninit to true in the
SystemNode TRA file as follows:
java.property.com.tibco.admin.jdbc.disable.validate.connection.oni
nit=true

The property can also be set for the SystemNode using the ActiveMatrix
Administrator UI via Infrastructure > Nodes > Select Node > Configuration >
JVM Configuration.

● Property: com.tibco.admin.jdbc.disable.validate.connection.oninit

● Value: true The default value of this property is false.

TAP-15631 When TIBCO ActiveMatrix Administrator Server was configured with HTTPs
using TLSv1.2 protocol, ActiveMatrix Administrator Command Line (CLI)
invocation failed with SSLHandshakeException, because ActiveMatrix
Administrator CLI did not support TLSv1.2.

With the fix, ActiveMatrix Administrator CLI can now successfully connect to
Administrator server using TLSv1.2 protocol without any additional
configuration.
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Key Summary

TAP-15554 ActiveMatrix 3.4.0 Runtime Platform now provides the option to validate the
configuration of JDBC Resource Templates (RT) and corresponding Resource
Instances (RI) by performing a test connection on the resource while it is being
installed. This way, if the configuration is incorrect, for example, wrong
credentials are specified, then the Resource Instance installation will fail, thus
giving you an opportunity to update the configuration and not waiting until
there is a business failure at invocation time. The validation can be disabled if
required. For details, refer to the Disabling Test Connection to a JDBC Resource
section in TIBCO ActiveMatrix® Service Grid Administration.

TAP-15539 DAA upload to TIBCO ActiveMatrix Administrator was not governed by
permission. This has now been fixed and only users authorized to upload DAAs
can now do so.

TAP-15538,

TAP-15752

When you update a resource template in ActiveMatrix Administrator UI, a dialog
box pops up using which you can select the affected resource instances for
reinstallation, and affected applications for restart. Subsequently, selected
resource instances are reinstalled and affected applications are restarted. If the
resource template is heavily used in the environment, ActiveMatrix
Administrator takes a long time to generate and execute the reinstallation and
restart tasks.

With this fix, if the affected applications have more than 1000 entities, a warning
message is displayed informing you that the affected nodes (that is, nodes on
which selected resource instances are installed) will be restarted, instead of the
applications, to speed up the entire process.

TAP-15536,

TAP-15548

In TIBCO ActiveMatrix Administrator, when a resource template (RT) is updated
by the user, a popup warning message is shown to inform the user that the
consequent resource instance (RI) reinstallation and application restart will take a
long time, especially if the RT in question is heavily used and in a large scale
setup. The user is also advised to go with the option of restarting the node(s) on
which the application(s) are deployed, instead of restarting each application, via
the Apply changes in resource template to runtime wizard.

TAP-15522 You cannot download certain files from ActiveMatrix Administrator by using the
external port.

TAP-15478 When creating a new TIBCO ActiveMatrix BPM node, a NullPointerException
was thrown due to the use of custom Substitution Variables (SVARs) by existing
nodes for shared resources. Moreover, the failure was abrupt and the root cause
was not revealed.

With this fix, the error is appropriately handled and NullPointerException is not
seen.

37

TIBCO ActiveMatrix® Service Grid Release Notes

https://docs.tibco.com/dyno/amsg/3.4.0/doc/html/GUID-C2504686-9EDE-4CE7-9011-9F1E9DE506B7.html


Key Summary

TAP-15465 The task creation process for application deployment in ActiveMatrix
Administrator takes a significant amount of time in case of large applications.
Additionally, the creation process did not record any actions in the logs which
made it difficult to track the application deployment process.

With this fix, important aspects of application deployment are recorded in the
logs to help you track application deployment for large applications easily.
Entries related to various deployment details are logged at INFO level in the
SystemNode.log using the com.tibco.amx.admin.api.application logger.

TAP-15423 ActiveMatrix Administrator took a long time to deploy a huge application. With
this fix, deployment time has been reduced significantly.

TAP-15414 If the ActiveMatrix Administrator database contained orphaned endpoint or
CapabilityLink entities, then ORA-02292: integrity constraint error was
observed when force-undeploying applications.

With this fix, applications can be force-undeployed successfully even if orphaned
endpoint or CapabilityLink entities are present, as these entities are deleted with
application itself.

TAP-15413 If the TIBCO ActiveMatrix Administrator database contained orphaned endpoint
or CapabilityLink entities, the ORA-02292: integrity constraint error was
observed when force-deleting applications.

With this fix, applications can be force-deleted successfully even if orphaned
endpoint or CapabilityLink entities are present, as these entities are deleted with
application itself.

TAP-15374 When using ActiveMatrix Administrator CLI, if a JVM argument was set with a
blank value for a node (jvmArg="-Damx.securitymanager.enabled=") in the
node_data.xml, the "Install or Sync" action failed with a
StringIndexOutOfBounds exception.

With this fix, the node performs the "Install or Sync" action correctly without any
JVM arguments.

TAP-15299 In the ActiveMatrix Administrator, if the number of Administrator "taskResult"
entries exceeded the default limit (10000), Administrator triggers TaskResult
cleanup to remove the older taskResults and UserAction entries, and keeps the
latest UserAction for each ActiveMatrix Administrator entity. During a CopyPFU
operation, this TaskResult cleanup was triggered and the latest UserAction was
removed for targeted Node. This is because there were some
PrepareForUndeploy (PFU) tasks pending on the node, and it resulted in failure
to complete the CopyPFU action, as the expected UserAction on target node was
no longer available in the ActiveMatrix Administrator database.

With this fix ActiveMatrix Administrator does not remove the latest UserAction
for the target node even if TaskResult cleanup is triggered, thus ensuring that
the corresponding CopyPFU action does not fail.
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Key Summary

TAP-15294 ActiveMatrix Administrator task creation for application deployment and
upgrade was not being logged, making it difficult to track their progress through
the optPreFlight, startPreFlight and deploy stages, especially in case of large
applications, such as BPM applications. Starting ActiveMatrix 3.4.0, logs are
printed at various milestones of application deployment and upgrade.

The tracking logs can be viewed in SystemNode.log (located at CONFIG_HOME
\tibcohost\instanceName\data_3.2.x\nodes\ SystemNode\logs

\SystemNode.log) under the com.tibco.amx.admin.api.application logger
at INFO level for SystemNode. You will find logs describing the various stages of
progress, such as "Starting optPreFlight", "optPreFlight is completed",
"Begin startPreFlight", "startPreFlight is completed", "Validating"
various aspects such as application distribution, bindings, substitution variables
and capabilities, followed by deployment and undeployment.

TAP-15293 In TIBCO ActiveMatrix Administrator, when distributing an already-deployed
application to a new node, Administrator was performing validations for existing
nodes even though the application was in sync. Since these validations were
unnecessary and excessive, they have now been skipped as part of this fix.

TAP-15278 In TIBCO ActiveMatrix BPM setup, creation of a new BPM Runtime Node was
hanging if its parent TIBCOHost had a prior Node that was force-uninstalled and
force-deleted. This occurred because an Administrator Task dependency of a
Node from a different TIBCOHost was incorrectly being appended to the
TIBCOHost in question. With this fix, no such dependencies of Nodes from other
TIBCOHosts are added when a Node is force-uninstalled and force-deleted, and
future Node creations under the TIBCOHost in question, will no longer hang or
fail.

TAP-15175 In ActiveMatrix Administrator, if the WSDL file location was changed during
application upgrade, the deployment of the application failed. With this fix, the
application deployment goes through successfully after upgrade even if WSDL
file location has been changed in the new version of application.

TAP-15169 In ActiveMatrix Administrator UI, a feature could be deleted even if it was used
by an application that is not deployed. When such an application was exported,
the export task failed with an error indicating that the feature was missing.

With this fix, deleting a feature which is used by an application, whether
deployed or not deployed, is no longer permitted. Administrator CLI with force
option can be used to force delete a feature. Additionally, if a feature used by an
application that is not deployed has been deleted, the exporting application task
no longer fails; it simply exports the application and DAA without the deleted
feature, and adds a warning message to the export task report.
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Key Summary

TAP-15166 Previously in TIBCO ActiveMatrix Administrator, when the System Application
com.tibco.amx.mcr.aggregator was deployed on the TIBCO ActiveMatrix
SystemNode or the Java property
amx.governance.sync.app.optimized.disable was set to "true" in the System
node's TRA file, and an application containing 1 or more policies was deployed
on a Runtime node (created after the Java property
com.tibco.admin.nodeservice.duplicate.node.name was set to true in the
SystemNode TRA file), the deployment of the application failed with the
following exception:
org.hibernate.NonUniqueResultException: query did not return a 
unique result

With this fix, the exception is no longer seen during deployment of such
applications in scenario described above.

TAP-15161 The Software Management > DAA page in ActiveMatrix Administrator took a
long time to load.

With this fix, the time taken to load the page is significantly reduced.

TAP-15159 If applications containing policies were undeployed on a node (created after the
Java property com.tibco.admin.nodeservice.duplicate.node.name was set
to true in the System node TRA file), the undeploy action failed with the error:
Failed to execute onRemoveCommandCompleted

and the policy was not successfully applied after redeploying the application.
With this fix, this error does not occur when applications with policies are
undeployed and policies are working fine after the applications are redeployed
on nodes described above.

TAP-15156,

TAP-15154

TIBCO ActiveMatrix Administrator, in case of BPM applications with multiple
Reference Binding versions, showed the binding path of the latest version as the
binding path of all the versions. The starting or stopping of any binding version,
would start or stop all the versions.

With this fix, ActiveMatrix Administrator shows the correct binding path for each
version of the reference binding. Consequently, the starting or stopping of a
particular binding version affects only the selected binding version, and all other
versions remain as they were.

TAP-15143 While creating a Keystore Provider resource template and uploading the keystore
file, a popup indicating the following error was shown "Error 500
INTERNAL_SERVER_ERROR", but the exact cause of the error was not displayed.
One of the reasons this issue can occur is when you do not have write permission
to the <CONFIG_HOME>\admin\amxadmin\shared\temp directory. With this fix,
the exact error is shown indicating the missing write permission.

TAP-15095 For an Identity Provider resource template, you could not set the value of
BinarySecurityToken (wssEnableProtectToken) through the ActiveMatrix
Administrator UI or CLI.

With this fix, the value of BinarySecurityToken can now be set while creating an
Identity Provider resource template using the ActiveMatrix Administrator UI and
CLI. The default value for this field is true.
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Key Summary

TAP-15057 While upgrading to a higher ActiveMatrix version, if one of the older services
had the name TIBCO ActiveMatrix Admin-amxadmin-instanceOne, the
startAllHosts command failed.

TAP-14908 A TIBCO ActiveMatrix BPM application can have multiple versions of an
application, the versions of which can be in different states. Of these, the states
"Prepare For Undeploy" state and "Running" are considered to be "in use". If you
browse to the Software Management > Application Template tab of
Administrator UI, the application versions in "Prepare For Undeploy" state were
not shown as "in use". With this fix, the "Prepare For Undeploy" application
versions are also shown as "in use".

TAP-14905 If you tried to remove any application DAA, feature or template with a missing
feature dependency from the Software Management tab, ActiveMatrix
Administrator threw an exception.

With this fix, users can now remove any application DAA, feature or template in
the ActiveMatrix Administrator even if a feature dependency is missing.

TAP-14371 Using the Enterprise Status page (In the ActiveMatrix Administrator UI, navigate
to Infrastructure > Enterprise Status), you can download logs, thread dumps and
TRA files of hosts and nodes within the enterprise. Logs for applications can also
be downloaded. For details, refer to the Host Tab, Node Tab and Application Tab
sub-sections in the Monitoring the Status of Entities from a Single Page section of
TIBCO ActiveMatrix Service Grid Administration.

TAP-14360,

TAP-14675

Using ActiveMatrix Administrator UI and CLI you can now download all the
logs related to an application as an aggregated archive, that combines logs from
the nodes on which the application is deployed, the hosts managing those nodes,
and SystemNode. The viewaction.html page is also part of the archive, and
displays all the user actions associated with the application. For details, refer to
the Downloading Logs for an Application section in TIBCO ActiveMatrix Service
Grid Administration.

TAP-14351,

AMRP-5575

ActiveMatrix 3.4.0 introduces the notion of aggregated node health, comprising
the cumulative status of the entities, such as application fragments, deployed on
the node and synchronization status of the node. This aggregated status can
deem the node as Healthy, indicating that none of the entities deployed or
running on the node have failed, or Not Healthy, when one or more entities are
in failed state. Interim statuses such as In Progress and Unknown are also
available.

Node Health goes beyond the "state" of the node, and views it in the context of its
contents. It can be accessed via GUI as well as Command Line Interface (CLI),
and can be used to troubleshoot failures. For details, refer to the Viewing an
Aggregated Status of a Node section in TIBCO ActiveMatrix Service Grid
Administration.
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Key Summary

TAP-13133 Deploying an TIBCO ActiveMatrix BPM application a second time after an earlier
upgrade failure that was not cleaned up using force undeploy no longer
prematurely removes the endpoints of the older version. Instead, users see a
validation error, and the second deploy action is blocked.

The error message is as follows:
Not allowed to deploy the version '<new version>' of application 
'<app name>'. This version may have failed to deploy earlier, and 
if so   it should be force undeployed first.

Force undeploy destroys BPM data for a given version, which means
all existing work items and process instances of the current version are
cancelled. Force undeploy must be used only when you are sure that
the BPM data for the version you are force undeploying is not needed
and its loss is acceptable. Otherwise, contact TIBCO Support.

TAP-12993 Installing a JDBC resource instance went into an infinite loop in the following
scenario:

● if the JDBC resource template was created with SSL

● if the SSL Client Provider and JDBC resource instance name were the same for
the JDBC resource template

With this fix, TIBCO ActiveMatrix Administrator throws an exception instead of
going into an infinite loop.

TAP-12973 You can now remove a feature using wildcard in the TIBCO ActiveMatrix
Administrator CLI configuration file when the force attribute is set to true even if
the feature is enabled on any node. When the force attribute is set to false only
those features that are not enabled on any of the nodes are deleted.

TAP-12895 When installing a node on a secure BPM environment (SSL-enabled
Administrator using a SSL-enabled Enterprise Messaging Server (EMS)), errors
were seen. These have now been resolved.
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Key Summary

WSBT-1151 By default in TIBCO ActiveMatrix the SOAP/HTTP Reference Binding Type (BT),
that is, the SOAP/HTTP client, sets the SOAP Action header name to soapaction
when constructing a SOAP request. The value of the header is set to the SOAP
Action of the targeted service endpoint's operation. This created a problem when
communicating with certain third-party legacy service providers, that expected
the SOAP Action header name to be SOAPAction.

To address this problem, the property
com.tibco.amf.bindingtype.soap.httpclient.setHTTPHeaderAsSOAPActio

n has been introduced to set the SOAP Action header name to SOAPAction
instead of soapaction. When this property is set to true, the header name is set
to SOAPAction, thus allowing successful end-to-end communication with non-
ActiveMatrix third-party legacy service providers.

To enable the fix, set the Java property
com.tibco.amf.bindingtype.soap.httpclient.setHTTPHeaderAsSOAPActio

n to true in the Runtime node's TRA file as follows:
java.property.com.tibco.amf.bindingtype.soap.httpclient.setHTTPHea
derAsSOAPAction=true

The property can also be set for the Runtime node using the Administrator UI via
Infrastructure > Nodes > Select Node > Configuration > JVM Configuration.

● Property:
com.tibco.amf.bindingtype.soap.httpclient.setHTTPHeaderAsSOAPAc

tion

● Value: true

WSBT-1148 In an ActiveMatrix enterprise with Policy Director Governance 1.1.0, when
Health Check was invoked on SOAP Binding Type (BT) endpoints secured with
WSS Authentication Signature Verification, the health check invocation failed
with the exception: Policy enforcement failed to authenticate the request. This
was a result of the internal request message processing for health check
execution, which resulted in tampering of the request message after it had been
signed by the client.

With this fix, the signature verification is carried out before the message is
internally modified for health check execution, and the exception is no longer
seen.

WSBT-520 The WSDL definition names used in the abstract and concrete WSDL definitions
were different. This issue has been fixed and the SOAP service name in the
composite uses the same name as defined in the abstract WSDL.

When generating concrete WSDL for SOAP Service Binding Type in TIBCO
ActiveMatrix, users can specify any namespace for the concrete WSDL, since this
namespace is externalized. The value can be same as abstract, or different,
depending on the business need.
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Known Issues

The table lists known issues in this release of TIBCO ActiveMatrix.

Key Summary

AMRP-5628 Summary: The node status does not include custom features during the
sequential checks when determining node health.

Workaround: None

AMRP-5445 Summary: If a Node Start action has been performed and the messaging bundle
is found to be in a Stopped state, the ActiveMatrix Administrator CLI hangs as
the EMS messaging bundle is not loaded in the OSGi. This happens due to a
limitation in the ActiveMatrix platform.

Workaround: Re-install the node as the node is in a corrupt state.

AMRP-5043 Summary: The timeout value of a promoted service or a component service
cannot be updated when a promoted service or a component service is
promoted.

Workaround: Specify the timeout value using the application-level property. For
example, if the name of an application is weatherApp, the following property can
be specified for the promoted service or component service that is promoted:
java.property.weatherApp.invocationTimeoutInMilliseconds.

For example,
java.property.weatherApp.invocationTimeoutInMilliseconds=12000 sets
the timeout value to 2 minutes.

AMRP-4754 Summary: If a service provider and a service consumer exist in the same BPM
application, undeploying the application might undeploy the service provider
even though the service consumer still requires the service provider.

Workaround: Separate the service consumer and the service provider so that
they’re both in two separate user applications.

AMRP-4744 Summary: If you upgrade ActiveMatrix BPM to release 2.2.0 and ActiveMatrix to
release 3.3.0, and upgrade a pre-existing user application so that it is a web
service implementation with REST enabled, you might see exceptions similar to
the following in the logs during the reply message event although the response is
successfully received:
[INFO ] stdout - java.io.IOException: Exception in opening zip 
file: C:\ProgramData\amx-bpm-2.1.0v12\tibco\data\tibcohost\Admin-
AMX BPM-AMX BPM Server\data_3.2.x\nodes\BPMNode\work\cf\cdfa6b9e-
d49d-4764-8623-fa331f8820c3\bundle
28 Aug 2013 16:52:32,824 [Framework Event Dispatcher] [INFO ] 
stdout - at 
org.eclipse.osgi.framework.util.SecureAction.getZipFile(SecureActi
on.java:291)
28 Aug 2013 16:52:32,824 [Framework Event Dispatcher] [INFO ] 
stdout - at 
org.eclipse.osgi.baseadaptor.bundlefile.ZipBundleFile.basicOpen(Zi
pBundleFile.java:87)

Workaround: Restart the node in which the application is deployed.
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Key Summary

AMRP-4736 Summary: You might not be able to start ActiveMatrix BPM as a Windows
Service after upgrading to ActiveMatrix release 3.3.0 from release 3.1.5 (or
previous releases) or ActiveMatrix BPM release 2.2.0 from release 2.1.0 (or
previous releases).

Workaround: If you encounter this issue:

1. Launch a command prompt where tibcohost.exe is located.

2. Uninstall existing ActiveMatrix BPM windows service by executing:
tibcohost.exe --uninstall

3. Install the windows service again by executing:
tibcohost.exe --install

AMRP-4013 Summary: Acceptor threads for HTTP connectors might consume excessive
amounts of CPU. The processing performance of any node that uses an HTTP
connector experiencing this issue might be affected when asynchronous IO is
involved.

Workaround: Edit the HTTP Connector resource template to use blocking IO. For
more information, see the section "Managing Resource Templates" in TIBCO
ActiveMatrix Service Grid Administration.

AMRP-3788 Summary: The LDAP resource template pool properties are not used when
initializing the connection pool.

Workaround: Configuring the connection pool using system properties specified
for the target node applies them to all instances deployed to that node.

Refer to the Oracle documentation for more information: http://docs.oracle.com/
javase/jndi/tutorial/ldap/connect/config.html.

AMX-17606 Summary: If you have upgraded from an earlier version of TIBCO ActiveMatrix
Service Grid including hotfixes to TIBCO ActiveMatrix Service Grid 3.4.0, when
you downgrade from TIBCO ActiveMatrix Service 3.4.0 to the earlier version,
you cannot revert the hotfixes applied earlier using revertPatch command.

Workaround: None

AMX-17411 Summary: When the
java.property.com.tibco.amx.decouple.Manual.Nodes property is set to
true in the TRA file, the SystemHost gets downgraded but the SystemNode fails
to downgrade.

Workaround:

1. Set the following property:
java.property.com.tibco.amx.decouple.Manual.Nodes=false

2. Restart ActiveMatrix Administrator.

3. Upgrade SystemHost to 3.4.0 and downgrade again.
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Key Summary

AMX-17409 Summary: Consider that an ActiveMatrix Administrator server is upgraded to
3.4.0 from a prior version and this server is downgraded with a wrong
ActiveMatrix Administrator port. In this case, if you do not test the connection to
the ActiveMatrix Administrator server before the downgrade, the TIBCO
Configuration Tool downgrade process hangs when checking ActiveMatrix
Administrator initialization at the "Checking for Admin initialization..." step.

Workaround: Kill the TIBCO Configuration Tool and provide correct information
for ActiveMatrix Administrator configuration. For example, port, SSL
information, and so on. Run the downgrade wizard again.

AMX-17393 Summary: When SAML Single Sign On configuration is enabled, if you delete
the browser cookies, after re-directing from error page to landing page, you are
not prompted for login credentials.

Workaround: Logout from the previous browser session.

AMX-17365 Summary: After upgrading to ActiveMatrix 3.4.0, the ActiveMatrix 3.3.0
Hotfix<x> runtime host fails to be downgraded back with the following error:
product feature 
com.tibco.amf.sharedresource.extensions.runtime.tibcohost.product.
feature 3.3.xx.000 contains a release unit 
com.tibco.amf.hpa.core.runtime.services.feature 1.5.0.003 that 
does not exist in the machine model

Workaround: Always select the Mediation Runtime option while installing the
Runtime Host profile for the remote hosts.

AMX-17351 Summary: Even after downgrading from 3.4.0 to a lower version and
uninstalling 3.4.0, the Configure TIBCO Service Performance Manager - V2.3
option is available in the TIBCO Configuration Tool. If you click the option, a
Null Pointer exception is thrown.

Workaround: None. Do not click the Configure TIBCO Service Performance
Manager - V2.3 option.

AMX-17343 Summary: If one of the EMS servers fails on an Amazon Web Services (AWS)
setup, the status of some nodes is shown as LOST_Contact.

Workaround: Reconnect the EMS connections by clicking Admin Configuration
> Admin Server > Transport Configuration tab > Administrator Reconnect.
After the reconnection, all the entities are shown as online.

AMX-17323 Summary: The TIBCO ActiveMatrix Governance Agent for TIBCO
BusinessWorks Notification screen of the Create TIBCO ActiveMatrix Policy
Director Administrator Server - V3.4 wizard is removed in 3.4.0. However, some
shared resources related to this screen (EMS ConnectionFactory, JMS Destination,
JNDI Connection) are created in ActiveMatrix Administrator. These shared
resources are added as an application property and can be viewed from the
ActiveMatrix Administrator UI:

● Application name: com.tibco.ampd.ogp.de

● Properties: bwJmsSharedResource and bwAgentAdapterJmsDestination

Workaround: The shared resources created by the screen are not used for
anything. You can ignore them.
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AMX-17316 Summary: After the uninstallation of ActiveMatrix Service Grid 3.4.0, some files
and folders are not removed from TIBCO_HOME. For example, the
tibamx_hostmanager.properties file from the TIBCO_HOME/amx/3.4/scripts
and TIBCO_HOME/tct/1.6 directories is not removed.

Workaround: None

AMX-17226 Summary: On IBM AIX, if the Deploy Log Service option is selected and you
create the ActiveMatrix Administrator server, the following error is displayed:
Error Loading Extension Registry error

Workaround: Clear the Deploy Log Service option when creating the
ActiveMatrix Administrator server.

AMX-17182 Summary: In the TIBCO Configuration Tool, host names or DNS names cannot
have underscores in their names. As a result, TIBCO Configuration Tool fails if
the name of the Available Group Listener contains underscores while
configuring the AlwaysOn Database Setup in SQL Server 2017.

Workaround: Do not use underscores in the name of the Available Group
Listener while configuring the AlwaysOn Database Setup on SQL Server 2017.

AMX-17144 Summary: On Microsoft Windows, when you try to update JRE by using TIBCO
Configuration Tool, occasionally the following error occurs:
Caused by: TIBCO-AMX-TOOLS-JREUPDATER-000048: Cannot write to the 
file. E:\AMX_v43\amx\3.4\scripts\rpflauncher_classpath_3.4.0.tra.

Workaround: Run the command two or three times until it succeeds.

AMX-17120 Summary: Occasionally because of manual intervention or execution of certain
scripts, the network time of the machine where Active Directory Federation
Services (ADFS) or WebApp is hosted might be out of sync and result in
authentication failure for response being too old or from future.

Workaround: The network time of the machine must be synchronized. For
Linux, the synchronization must happen with the Network Time Protocol server.
For Windows, use the Windows time service. There are standard operating
system level procedures for synchronizing the machine network time.

AMX-16828 Summary: If you invoke a REST service binding with an OpenID Policy through
a SOAP client such as SoapUI, it always sends an Access Token, which is an
opaque token. Access Tokens are not, currently, supported.

Workaround: Use the ID Token (which is a JWT token) generated by the Access
Token URI to send the request in SoapUI.

AMX-16800 Summary: On a replication setup, when upgrading from 3.3.0 to 3.4.0, the
primary ActiveMatrix Administrator server does not get started correctly after a
successful upgrade.

Workaround: Restart the ActiveMatrix Administrator server.
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AMX-16672 Summary: Double downgrade is not supported. For example, downgrading
from 3.4.0 to 3.3.1 to 3.3.0 fails with the following errors:
TIBCO-AMX-CLI-000944: Failed to downgrade TIBCO Host instance(s).
TIBCO-AMX-CLI-000942: Downgrade TIBCO Host instance <instance 
name> is not possible.

Workaround: None

AMX-16634 Summary: For an upgraded TIBCO host, the tibcohost describeHost
command incorrectly shows the upgrade status as None.

Workaround: None

AMX-16542 Summary: After upgrading TIBCO Business Studio to TIBCO ActiveMatrix 3.4.0,
it is no longer supported on the Mac operating system.

Workaround: None

AMX-16505 Summary: On a replicated setup, if one of the servers is downgraded, the version
of the TIBCO ActiveMatrix REST BT Administrator Plug-in shows as 3.4.0
instead of showing the older version.

Workaround: None

AMX-16084 Summary: The Service Performance Manager (SPM) dashboard does not work
with EMS fault tolerance mode.

Workaround: None

AMX-16083 Summary: If a Java project has errors (faults) configured in RRC and has
execution environment as JAVASE-1.6 or lower, DAA generation fails.

Workaround: To generate the DAA file, make sure that the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. It
allows you to create the DAA and deploy it at runtime.

AMX-16017 Summary: When 3.4.0 is installed over 3.3.0 with Hotfix 17 applied to it, if all the
check boxes (3.3.0, Hotfix 17, and 3.4.0) are selected in the Custom Uninstall
dialog box, the following error is displayed during the TIBCO ActiveMatrix SPM
Dashboard uninstallation:
ANT Task: TIBCO ActiveMatrix Pre-Uninstallation - ActiveMatrix 
SPM Dashboard has failed.

Workaround: Uninstall the products in the following order:

1. 3.4.0

2. 3.3.0 Hotfix 17

3. 3.3.0
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AMX-16016 Summary: Downgrading SystemHost from ActiveMatrix 3.4.0 to an earlier
version fails if the CONFIG_HOME where the SystemHost is present contains other
runtime hosts that are bound to a different ActiveMatrix Administrator server
instead of the ActiveMatrix Administrator server from the selected CONFIG_HOME.

Workaround: Ensure that all the runtime hosts that are in the selected
CONFIG_HOME must be bound to the ActiveMatrix Administrator Server from the
same CONFIG_HOME.

AMX-15975 Summary: Even when the command line interface is used, the notification
transport update fails with the following error message:
TIBCO-AMX-ADMIN-021085: Failed to update the notification 
transport!, Caused by:
TIBCO-AMX-ADMIN-021281: The number of hosts in this enterprise is 
more than 10. 
Please use the Administrator Command Line Interface for updating 
the Notification Transport.

Workaround: None

AMX-15840 Summary: After upgrading from 3.2.0 to 3.4.0, the Mediation application
template shows version as 3.4.0.007 instead of 3.5.0.007.

Workaround: None

AMX-15806 Summary: When a DAA created in 3.3.0 with javax.servlet is run as a
composite application in 3.4.0 (Deployment Artifacts > right-click the DAA file >
Debug As > Composite application), RAD starts but fails with Provisioning
Node errors.

Workaround: Re-create the DAA in 3.4.0.

AMX-15775 Summary: In 3.4.0, an HTTP connector is created as non-blocking by default.
That is, the Use Non-Blocking IO Sockets check box on the Advanced tab is
selected by default. When this check box is selected, the Acceptor Threads field
on the General tab is disabled and 1 is used as the default number of Acceptor
Threads.

For an internal HTTP connector, if the Use Non-Blocking IO Sockets check box
is cleared and a value greater than 1 is specified in the Acceptor Threads field, all
except one of the acceptor threads are in a blocked state.

Workaround: Keep the Use Non-Blocking IO Sockets check box on the
Advanced tab cleared.

AMX-15756 Summary: During installation using the GUI mode, a name cannot be specified
for the installation environment.

Workaround: Install using the Silent installation mode if you want to specify an
environment name.
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AMX-15614 Summary: When creating an ActiveMatrix Administrator server by using TIBCO
Configuration Tool, if the Oracle user name has quotes (“ ”) and hyphen (-),
TIBCO Configuration Tool fails to create the ActiveMatrix Administrator server
and returns the following error:
Caused by: java.sql.SQLSyntaxErrorException: ORA-00942: table or 
view does not exist

Workaround: Avoid using quotes (“ ”) and hyphen (-) in the user name.

AMX-15592 Summary: For HP-UX machines, the Patch Manager functionality to shutdown
TIBCOHost instances before running the commands applyPatch and
revertPatch is not supported. For the same commands, the ability to start the
TIBCOHost instances after running the commands is also not supported. That is,
if applyPatch or revertPatch commands are run with the -handleStart or -
handleStop arguments, the commands does not work as expected. In this case,
the shutdown and startup of TIBCOHost instances must be handled manually.

Workaround: Run the applyPatch and revertPatch command without -
handleStart and -handleStop arguments, and handle shutdown and startup of
TIBCOHost instances manually.

AMX-15569 Summary: The -ignoreNodeStartupMode argument of the Host Manager's
startAllHosts command does not work for a Microsoft Windows NT host. For
a Microsoft Windows NT host, it starts a node configured for automatic startup
but does not start a node configured for manual startup.

Workaround: Start Microsoft Windows NT host or service manually.

AMX-15379 Summary: If application App1 with promoted service Service1 containing a
SOAP/HTTP binding Binding1 is deployed in environment Env1, and another
application App1 with promoted service Service1 containing a SOAP/JMS
binding Binding1 is deployed in environment Env2, the TIBCO ActiveMatrix
SPM dashboard shows an incorrect binding type for the application App1
deployed in Env2. That is, the dashboard shows the binding type as SOAP/HTTP
instead of SOAP/JMS. This issue applies to promoted references as well.
Additionally, it applies to all binding types - SOAP/HTTP, SOAP/JMS, and JMS.

Workaround: None
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AMX-15261 Summary: On a machine which has a TIBCO ActiveMatrix 3.3.0 Hotfix installed,
while upgrading to ActiveMatrix BPM 4.0.0, the TIBCO ActiveMatrix version is
downgraded if all the following options are selected:

● Upgrade ActiveMatrix TIBCO Host Instance
● Upgrade ActiveMatrix Administrator
● Upgrade Nodes Hosting ActiveMatrix BPM Instance
● Upgrade ActiveMatrix BPM Instance Application [Upgrading Database]

Workaround:

1. Stop tibcohost.

2. Apply the TIBCO ActiveMatrix 3.3.0 Hotfix again by running the patch
manager.

3. Start tibcohost.

4. From ActiveMatrix Administrator, check systemnode and bpmnode. The
expected hotfix version is displayed.

5. Launch TIBCO Configuration Tool to upgrade to ActiveMatrix BPM 4.0.0.
Select the last two options:

Upgrade Nodes Hosting ActiveMatrix BPM Instance

Upgrade ActiveMatrix BPM Instance Application [Upgrading Database]

AMX-13851 Summary: If you use Microsoft SQL Server 2012 as an external database server
and use its Mirror Mode to establish a connection to a secondary failover
database server, TIBCO ActiveMatrix Administrator fails to connect to either
database server.

Workaround In addition to providing the JDBC URL of the mirrored servers in
SQL Server 2012, you must set the IP and hostname of both the primary and
secondary database servers in the hosts file. The location of the hosts file depends
on the operating system:

● Windows: ROOT_DIR\system32\drivers\etc\hosts

● UNIX/Linux: /etc/hosts

For example, you have two database servers. The primary server's IP is
192.167.71.42 and its hostname is amx-db42; the secondary server's IP is
192.167.71.60 and its hostname is amx-db60. You would provide the following
JDBC URL for these two mirrored primary and secondary servers:
jdbc:sqlserver://
192.167.71.42:1433;databaseName=db1;failoverPartner=192.167.71.60

To ensure that ActiveMatrix Administrator successfully connects to both servers
and allows for seamless switching between them using SQL statements, you
must add the following entries to the hosts file:
192.167.71.42 amx-db42
192.167.71.60 amx-db60
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AMX-11970 Summary: In a replicated ActiveMatrix Administrator server setup, if you
deploy to the system node applications with policies applied on them, the
policies are not enforced after upgrade.

Workaround: First undeploy and then redeploy these applications after
upgrading all system nodes.

BJMS-1490 Summary: JNDI Resource Template using Custom Property for LDAP Provider
URL will not get installed.

Workaround: Provide URL in the Provider URL field on the Resource Template.

BJMS-1382 Summary: If JMS Binding configured with JMS AL Least Once Policy is
undeployed before the redelivery count is exhausted, and deployed again, the
message is not redelivered.

Workaround: None

BJMS-1374 Summary: If JMS Binding is configured with JMS At Least Once Policy and the
EMS Provider URL used for connection is fault tolerant, the message is not
redelivered in case EMS crashes.

Workaround: None

BJMS-755 Summary: Enterprise Message Service XA Resources from orphaned transactions
do not disappear after transaction timeout from Enterprise Message Service
server. They are seen on the Enterprise Message Service server as a part of show
transactions command.

Workaround: Re-start the Enterprise Message Service server. As there is no
locking in messaging associated with an XA resource, this issue is not serious.

BJMS-736 Summary: When a 2.x project containing a JMS binding is migrated to 3.x the
JNDI resource template required for looking up the destination are not created
and the generated warning does not clearly state that JNDI resource templates
need to be created.

Workaround: Manually create JNDI resource templates required for defining
inbound and outbound destination configurations.

BJMS-726 Summary: On re-starting Enterprise Message Service, for in-flight messages,
transaction does not get committed. Re-delivery happens and message is
forwarded to error queue.

Workaround: Recover the requests from the error queue.

BJMS-718 Summary: For JMS binding, the SDS UI allows you to set Context Parameters of
type Message. This is not supported for JMS Binding.

Workaround: Do not use type Message for Context Provisioning related to JMS
Binding.

BJMS-636 Summary: The show connection command in the TIBCO Enterprise Message
Service administration tool ems-admin does not contain "ClientID" value for
connections created by JMS resource instances for outbound connections.

Workaround: None
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BJMS-603 Summary: ActiveMatrix Administrator does not validate that an application
with JMS Transacted One-Way policy set should be deployed on a single node.

Workaround: Ensure that the JMS binding that has a JMS Transacted One-Way
Policy is deployed on the same node as that of component(s), it is wired to.

BJMS-355 Summary: When a JMS service is deployed in LB setup over routed queues, the
following message is displayed and the service does not start:
javax.jms.IllegalStateException: Not allowed to use transacted 
session on routed queues

Workaround: Enterprise Message Service does not support transactions on
routed queue consumers. Enterprise Message Service 6.0 added an explicit check
to prevent this. You can restore the old behavior by setting the following
configuration parameter:

allow_unsupported_tx_routed_q_consumers = true

BJMS-139 Summary: If you rename an operation in a WSDL file, JMS bindings on
composite services and references are not updated correctly.

Workaround: Create new JMS binding after renaming the WSDL operation or re-
assign the WSDL file to existing JMS binding.

DSS-982 Summary: Changing or updating the TIBCO Credential Server (TCS) certificate
results in host security failure.

Workaround: None

DSS-813 Summary: While upgrading to ActiveMatrix release 3.3.0, you might see benign
errors similar to the following example:
[ERROR]com.tibco.trinity.runtime.base.provider.identity.CipherSupp
ort

Workaround: Such errors are harmless and do not mean that the upgrade failed.
No action is required.

HKAM-411 Summary: On the Solaris operating system, the AMXNode microagents are not
shown in the Hawk Display.

Workaround: None

HKAM-402 Summary: After upgrading ActiveMatrix 3.3.0 to ActiveMatrix 3.4.0, when you
call the getConfig method, the Monitoring Application State is shown as NOT
CONFIGURED.

Workaround: Before upgrading to ActiveMatrix 3.4.0, apply ActiveMatrix 3.3.0
Hotfix 10 or higher.
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HKAM-397 Summary: When Hawk ActiveMatrix Plug-in (HKAM) is used for large scale
systems, tibhawkagent stops automatically with the following error
RV: DrainQueue: out of memory.

Workaround: If HKAM is configured with more than 10 hosts, increase memory
of tibhawkagent.

To change memory of tibhawkagent:

1. Open tibhawkagent.tra located at <hawk.config.home>/tibco/cfgmgmt/
hawk/bin.

2. Change values of -XX:MaxPermSize, java.heap.size.initial and
java.heap.size.max based on number of hosts.

For 60 hosts, the following values are recommended:

● java.heap.size.max = 4 GB

● -XX:MaxPermSize = 1 GB

HKAM-389 Summary: After a Notification Transport Server Configuration update, the
TIBCOHost's HKAM rulebases point to the previous Notification Transport
Server Configuration.

Workaround: After a Notification Transport Server Configuration update, you
must manually update the TIBCOHost's HKAM rulebases.

HKAM-384 Summary: When HKAM is configured on a large scale setup, invoking a method
on a Host microagent fails with a timeout.

Workaround: Change the default HKAM rulebase for host and node. Make it
event-driven rather than polling at a fixed interval.

HKAM-374 Summary: On Windows Server 2008 R2, if a node belongs to a host created with
a Windows NT service, invocation of the following methods on the node
microagent fails with a StatsDataAdapter is null error:

● changeMonitoringConfig

● getBindingOperationStats

● getComponentOperationStats

● getConfig

Workaround: None
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HKAM-373 Summary: When QIN update is performed on a host which is already configured
with HKAM, the EMS related information in the hawkems<host_name>.hma file
points to the old notification server.

Workaround: Change the EMS values for -user, -encryptedPassword, and -
server of the new notification server manually in the hawkems-
<host_name>.hma file.
<arg>-user</arg>
<arg>${new_username}</arg>
<arg>-encryptedPassword</arg>
<arg>${new_password}</arg>                 
<arg>-server</arg>
<arg>${new_notification_server_url}</arg>

HKAM-343 Summary: On Solaris, hawk.log shows the following error and method
invocation for CLEventPublisherMicroAgent does not return any data:
Error loading microagent from 
com.tibco.hawk.microagent.commonlogging.publisher.CLEventPublisher
MicroAgent: java.lang.IllegalArgumentException

Workaround: None

HKAM-337 Summary: For a node, you cannot view statistics for a WebApp component using
the onComponentOperationStats Hawk method.

Workaround: None

HKAM-336 Summary: For a node, you cannot view statistics for a WebApp component using
the getComponentOperationStats Hawk method.

Workaround: None

HKAM-266 Summary: If the ActiveMatrix Administrator server or TibcoHost instance is
configured to use SSL-enabled Enterprise Message Service on AIX platform, and
Hawk 5.0 is installed, then starting Hawk Agent fails with an error.

Workaround: Use Hawk 4.9 instead of Hawk 5.0.

HKAM-264 Summary: You cannot change the timeout of method invocation for Custom
microagent.

Workaround: None

HKAM-253 Summary: Hawk Display shows multiple entries for node Service microagent
when rulebases for TibcoHost or nodes are invoked after the TibcoHost or node
crash.

Workaround: Click Done, and open the microagent again. Alternatively, restart
Hawk Display.

HKAM-251 Summary: Continuous error messages are seen in the hawk.log file after starting
tibhawkagent.exe on HAWK 5.0. Hawk 5.0 is unable to run powershell.exe
used in TibcoHost rulebase.

Workaround: Prefix powershell.exe in the rulebase of the TibcoHost with the
absolute path of powershell.exe.
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HKAM-250 Summary: When using Hawk 5.0, logs are not generated in the CONFIG_HOME/
hkam/<host_instance_name>/logs folder. The Hawk Agent shows errors
related to slf4j in the Hawk logs.

Workaround: Remove the slf4j jars and jars with different versions of slf4j
from the agent classpath.

HKAM-249 Summary: The Stop Reason and Reason Code arguments are not updated for the
onNodeEvent method after calling stopNode.

Workaround: None

HKAM-242 Summary: Hawk 5.0 cannot find Windows PowerShell.

Workaround: Prefix powershell.exe in the rulebase of the TibcoHost with the
absolute path of powershell.exe.

HKAM-237 Summary: On creating a node in the ActiveMatrix Administrator web interface,
its rulebase is created in the CONFIG_HOME/hkam/<host_instance_name>/
rulebases folder. If the node is deleted, the HAWK.log file continuously produces
errors.

Workaround: Manually delete the rulebase to avoid error entries in the HAWK.log
file.

HKAM-193 Summary: Hawk ActiveMatrix Plug-in displays some ActiveMatrix applications
or components in runtime state as uninstalled, but ActiveMatrix Administrator
or nodeutil do not show these applications.

Workaround: Restart Hawk Agent to clear the cache.

IWAP-725 Summary: (ActiveMatrix BPM only) If you change a substitution variable (such
as %%httpConnectorPort%%) from a hardcoded value (such as 443)—or vice
versa—in an HTTP connector resource template, Workspace and Openspace fail
to open and you might see an error similar to the following example in the logs:
[ERROR] com.tibco.n2.rtc.ap.ActionProcessor - [ERROR] - 
{WS_REQUEST_EXCEPTION} - Workspace caught an Exception 
¬{extendedMessage=`Invalid Security Context: Missing requested 
attribute

Workaround Redeploy the application and restart Workspace and Openspace.

IWAP-669 Summary: If you add a WebApp component to an imported project created in
ActiveMatrix 3.2.0 that already has a WebApp component, every time you select
the newly added WebApp component after selecting the original WebApp
component the Thread Context Class Loader Type drop-down list in the
Properties > Implementations tab is disabled.

Workaround: Deselect the newly added WebApp component (by selecting any
area on the canvas that is not the original WebApp component from the imported
project), then select the newly added WebApp component again. The Thread
Context Class Loader Type drop-down list is enabled.

IWAP-223 Summary: In the web.xml file, resource-ref elements are not supported.

Workaround: None
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IWAP-72 Summary: The WebApp component does not have an option to modify the Web
Application connector during deployment in TIBCO Administrator UI.

Workaround: To configure or change the connector name in TIBCO ActiveMatrix
Administrator:

1. In TIBCO Business Studio, open the project containing the Web Application
component.

2. Promote the defaultConnector property to a composite level:

a. Select the defaultConnector property on the component.

b. Right-click and select Promote.

3. Make the composite property a substitution variable so it can be substituted
in TIBCO Administrator before deployment.

4. Right-click on composite and select Create DAA.

5. In ActiveMatrix Administrator, make sure a connector with the same name is
created in ActiveMatrix Administrator and deployed on to the node before
the Web Application DAA is deployed.

MCR-2002 Summary: If you have configured Microsoft SQL Server 2012 as a database for
Administrator, invoking a custom DAA might result in harmless exceptions
similar to the following examples:
Caused by: com.microsoft.sqlserver.jdbc.SQLServerException: 
Violation of UNIQUE KEY constraint 
'UQ__Mcr2Stat__1C012A471DC5DDE4'.
Cannot insert duplicate key in object 'dbo.Mcr2StatisticsMetric'. 
The duplicate key value is (93, 21, 22, 3, -1).
at 
com.microsoft.sqlserver.jdbc.SQLServerException.makeFromDatabaseEr
ror(SQLServerException.java:216)
at 
com.microsoft.sqlserver.jdbc.SQLServerStatement.getNextResult(SQLS
erverStatement.java:1515)
at 
com.microsoft.sqlserver.jdbc.SQLServerPreparedStatement.doExecuteP
reparedStatement 
SQLServerPreparedStatement.java:404)                     

Workaround: None

MCR-1995 Summary: If you have configured IBM DB2 as an external database, you might
see harmless exceptions similar to the following examples in SystemNode.log:
Retrying database transaction after error: Processing of metric 
requestsIn for event 
com.tibco.governance.amxserviceprobe.ServiceProbeInstruments.Servi
ceRequestIn failed for measure Total and time window Since 
Started Time Window 
Retrying database transaction after error: Processing of metric 
faults for event 
com.tibco.governance.amxserviceprobe.ServiceProbeInstruments.Servi
ceExecutionTime failed for measure Total and time window Since 
Started Time Window     

Workaround: Such exceptions are benign and do not require any action.
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MCR-1943 Summary: If you have upgraded to ActiveMatrix release 3.3.0 from a prior
version and attempt to replicate the upgraded configuration, deploying the
replicated configuration might fail.

Workaround: Replicate your configuration before upgrading to ActiveMatrix
release 3.3.0.

MCR-1823,

TAP-10602

Summary: The value for the uptime displayed in the infrastructure dashboard
screens are accounted from the time a request is made to the application by
invoking the endpoint or through an internal call from another application.

If an application is deployed and not used, the value for uptime is 0.

Workaround: None

MCR-1422 Summary: If nodes are restarted when the SystemNode is down, the Uptime and
Since Started statistics are not reset.

Workaround: Either make sure that the system node is running using admin
replication or restart the applications for which incorrect statistics are seen.

MCR-1350 Summary: The number of components reported for a given node in the
Enterprise Graphical View includes components that belong to the ActiveMatrix
Platform Application. The Dashboard component count does not include these
components.

Workaround: None

MCR-1226 Summary: The Endpoint, Service, and References tabs display an incorrect
value for Avg Comp Process Time when extended monitoring is enabled. The
value displayed is Req Comp Time.

Workaround: The correct average component processing time is available in the
Components and Applications tabs.

MCR-1205 Summary: If the TibcoHost is shutdown while the dashboard is running, the
following error message is seen in the SystemNode log files:
[ERROR] org.apache.axis2.engine.AxisEngine - 
bean:name=govObjFilterServiceMBean

Workaround: None. This error can be safely ignored.

MCR-1204 Summary: Stopping the TibcoHost instance occasionally causes exceptions to be
thrown in the log file. During a graceful stop of TibcoHost instance there might
be some exceptions in the log file with the root cause. For example:
Caused by: java.lang.RuntimeException: Statistics aggregator is 
closing down, rolling back transaction

Workaround: Ignore the error.

MCR-1162 Summary: Statistics for Web Application components do not display in the
dashboard.

Workaround: None
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MCR-876 Summary: Status value is Unknown and uptime is empty when the same
application is deployed on two nodes across environments.

Workaround: Change the application name during deployment. It must be
unique for an enterprise for dashboard to show correct status and uptime.

MCR-800 Summary: When a component reference is promoted, component reference
metrics show zero values. All metrics are shown on the promoted reference and
reference endpoint.

Workaround: View metrics on the promoted reference.

MCR-753 Summary: In the Dashboards > Infrastructure screens the application request
count includes requests counts from all services promoted to application level. In
addition, it incorrectly includes reference invocations count from all references
promoted to application level.

Workaround: None

MCR-521 Summary: If a node is stopped or started several times while SystemNode is
down, the last stop or start time of SystemNode is used to calculate the node’s
uptime percentage. Other stops and starts are missed and not used in uptime
calculation.

Workaround: Configure the ActiveMatrix Administrator server in fault tolerant
mode.

MED-3306 Summary: SOA projects created by the AutoMediate Tool might fail to be
deployed by the tool if the projects have SOAP over JMS bindings.

Workaround: Re-create all JMS Connection Factory and Destination resources in
TIBCO Business Studio.

MED-2907,

MED-2885

Summary: The Mediation editor does not reload changes to the XSD unless the
project is restarted.

Workaround: To resolve this:

1. Import all projects into the workspace.

2. Restart TIBCO Business Studio.

3. Run Project > Clean > Clean all projects.

MED-2055 Summary: The Transform task does not handle the Byte Order Mark (BOM) in
external stylesheet files.

Workaround: Open the stylesheet in a text editor and save it manually in a
format without using BOM.

MED-1827 Summary: Deploying a mediation application that uses custom XPath functions
and if the custom XPath function plug-in is not deployed, results in errors at the
time of deployment.

Workaround: None
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MED-1739 Summary: When adding a PortType with many (about 50+) operations, the
validation begins before the mediation flow is fully updated. This causes error
markers to appear on the mediation operations when no actual problems exist.

Workaround: Select Project > Clear from the menu bar and the validation
restarts. The error markers disappear, unless there are actual problems that
remain.

MED-1736 Summary: Dragging and dropping a WDSL onto a mediation flow results in the
following error:
Receive Wrong Transfer data 

Workaround: None

MED-1703 Summary: Creating schema using the Create button creates the schema for CMT
model plugin wizard but does not set it.

Workaround: Once the schema is created, you can browse and select the schema
in the wizard to set it for both Input and Output Schemas in the plugin wizard.

MED-1652 Summary: The message type context property does not specify an unbound
message even though the selection list contains all message elements in the
WSDL. An unbound message is one that is not used for Input, Output, or Fault
parts.

Workaround: Only select unbound message elements for context properties.

PD-4435 Summary: When the Basic or UsernameToken Authentication Governance
Control is enforced on the object group with a WebApp and REST binding
member, the policy does not work when used as UsernameToken Authentication
but works when used as Basic Authentication.

Workaround: None

PD-4431 Summary: A policy is not enforced for an application if the application is
deployed before deploying the Policy Director Governance server.

Workaround: None

PD-4429 Summary: Even after successfully downgrading from 3.4.0 to ActiveMatrix 3.3.0
(with Hotfix 23 and Policy Director Hotfix 02 installed), the following plug-ins
show 3.4.0 as the version:

● TIBCO ActiveMatrix Operations Governance Platform Administrator plug-in

● TIBCO ActiveMatrix Administrator Governance Policy Director admin plug-
in

Workaround: This issue does not have a functional impact; everything works as
expected.

PD-4423 Summary: Logging policy is not supported by the ActiveMatrix Administrator
server (with ActiveMatrix Policy Director Governance services) of ActiveMatrix
3.4.0 when the server is configured with SSL-enabled Enterprise Message Service.

Workaround: None
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PD-4420 Summary: On the Governance tab of the ActiveMatrix Administrator UI, the
applications that have policies applied to them incorrectly show their
undeployed policies as Active.

Workaround: None

PD-4371 Summary: OpenID Connect authentication is not supported via Policy Director
Governance in this release. Consequently, the following operation in TIBCO
ActiveMatrix Administrator fails:

Governance > New > Authentication By OpenID

Workaround: None
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PER-1931 Summary: Nonce is not supported for messages sent from TIBCO ActiveMatrix
BusinessWorks to ActiveMatrix BPM. Therefore, if you use TIBCO ActiveMatrix
BusinessWorks as a client to invoke an ActiveMatrix BPM process as service, you
might see the following error:
PolicyEnforcement Failed to Authenticate the request.

Workaround: Modify the WSDL generated by ActiveMatrix to add the following
schema, WSDL message, and WSDL input in binding to successfully invoke an
ActiveMatrix BPM service from TIBCO ActiveMatrix BusinessWorks.

Schema
<xsd:schema elementFormDefault="qualified" 
targetNamespace="http://schemas.xmlsoap.org/ws/2002/07/secext">
<xsd:import namespace="http://schemas.xmlsoap.org/ws/2002/07/
utility"/>
<xsd:element name="Security" type="s2:Security"/> 
<xsd:complexType name="Security">
<xsd:sequence>
<xsd:element minOccurs="0" maxOccurs="1" name="UsernameToken" 
type="s2:UsernameToken"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="UsernameToken">
<xsd:sequence>
<xsd:element minOccurs="0" maxOccurs="1" name="Username" 
type="xsd:string"/>
<xsd:element minOccurs="0" maxOccurs="1" name="Password" 
type="xsd:string"/>
</xsd:sequence>
</xsd:complexType>
</xsd:schema>

WSDL Message
<wsdl:message name="PUTSecurity">
<wsdl:part name="Security" element="s2:Security"/>
</wsdl:message>

WSDL Input in Binding
<soap:header message="tns1:PUTSecurity" part="Security" 
use="literal"/>

For example:
<wsdl:binding name="ProcessPackageProcess_EP" 
type="tns1:ProcessPackageProcess">
<soap:binding style="rpc" transport="http://schemas.xmlsoap.org/
soap/http"/>
<wsdl:operation name="CatchMessageEvent">
<wsdl:documentation/>
<soap:operation style="rpc" soapAction="CatchMessageEvent"/>
<wsdl:input>
<soap:header message="tns1:PUTSecurity" part="Security" 
use="literal"/>
<soap:body use="literal" parts="in1"/>
</wsdl:input>
<wsdl:output>
<soap:body use="literal" parts="out1"/>
</wsdl:output>
</wsdl:operation>
</wsdl:binding>
<soap:header message="tns1:PUTSecurity" part="Security" 
use="literal"/>
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PER-714 Summary: Multiple SOAP references deployed in a single node sending different
credentials to a single SOAP service protected with Basic Authentication Policy
could result in erroneous authentication failures for some of the references even
if they are sending valid credentials.

Workaround: You can either:

● Deploy these references in different nodes

● Configure these references with different HTTP client resource instance
configurations

PER-632 Summary: For proper policy enforcement, every composite containing a web
application component must have a different context root.

Workaround: None

PER-609,

PER-623

Summary: The UsernameTokenAuthentication and WSSProvider are
incompatible policies. These policies have redundant functionality, but they
cannot co-exist on the same SOAP service.

UsernameTokenAuthentication authenticates using only the username token in
the WS-Security header.

WSSProvider authenticates using any available information in the WS-Security
header.

Both policies remove the WS-Security header from the message after successful
authentication. If both policies are in effect at the same service, when the first one
(WSSProvider) succeeds, the second (UsernameTokenAuthentication) must fail,
because the WS-Security header is no longer available. This failure causes request
messages with proper credentials to fail erroneously.

Workaround: Do not apply the policies WSSProvider and
UsernameTokenAuthentication together at the same SOAP service.

PER-583 Summary: For bundled policies added in this release, if the resource instance(s)
used in the policy is reinstalled, policy enforcement fails.

Workaround: Redeploy the application after reinstalling the resource instance(s).

PER-557 Summary: The policy AuthorizationByRole does not support nested groups.

Suppose user A is a member of group B, which is a subgroup of group C. If
group C has access permission to request an operation, and user A attempts to
request that operation, then the request fails. That is members of group B do not
inherit access permission from group C.

Workaround: Configure access permissions directly in each subgroup (in this
example, in group B).

PER-49 Summary: When configuring an LDAP Authentication resource template in
Administrator, the option to generate SAML 1.1 assertion is not supported by
platform policies.

Workaround: When configuring an LDAP Authentication resource template,
accept the default setting to generate SAML 2.0 tokens.
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RSBT-784 Summary: Open ID authentication is not supported when invoking REST Service
Bindings using the Swagger UI. Only basic authentication is supported.

Workaround: None

RSBT-779 Summary: For a REST binding, when using the POSTMAN REST client, the basic
or username token authentication policy is not enforced if you do not provide
authentication.

Workaround: None

RSBT-721 Summary: In the Swagger UI, if SSL is enabled over a REST binding that uses the
self-signed certificate and you send a request over HTTP, it returns the following
error:
TypeError: Failed to fetch

Workaround: Add the certificate as an exception in the browser.

RSBT-719 Summary: In Swagger UI, on selecting parameter content-type as 
application/bjson, the schema is not populated with the correct BJSON
format.

Workaround: You can manually form the request payload of type Badgerfish
JSON (application/bjson) to get a proper response.

RSBT-716 Summary: To test an endpoint, when you select the request content-type as
application/xml, an XML request payload is generated in the Swagger UI. The
payload does not include the namespace for the elements that are defined in an
imported XSD, that is, namespace is not pre-populated in the payload.

Workaround: Manually provide a namespace for such elements.

RSBT-603 Summary: When the Java property
com.tibco.amf.runtime.bindingtype.rest.extendedJsonConversion is set
to true for a runtime node in the REST Resource Configuration (.RRC) file for a
reference binding, and if the POST request contains a JSON array with exactly
one JSON element in it (as specified below), the JSON array is treated as a single,
non-array element. This results in a NullPointerException at runtime when
multiple elements are sent as part of the request.

Erroneous usage:
{"addRequestOperation": {"Arrays":[{"Key":"key1", "Value": 
"value1"}]}} 

Workaround: In the RRC file, specify multiple elements in the JSON Array
element as follows

Correct usage:
{"addRequestOperation": {"Arrays":[{"Key":"key1", "Value": 
"value1"},{"Key":"key2", "Value": "value2"}]}}

With this change, the Array object is treated as a JSON array at runtime and the
NullPointerException is not seen.

64

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

RSBT-408 Summary: A Null Pointer Exception is thrown when a Pass Through Mode
sample project is deployed in RAD.

Workaround: Deploy the project in ActiveMatrix Administrator.

RSBT-398 Summary: A REST service binding is updated after an operation is added to a
WSDL.

Workaround: None

RSBT-391 Summary: After renaming an RRC file through the Process Explorer, the name of
the file is updated in the reference > Bindings tab > Rest Resource Configuration
File link.

Workaround: None

RSBT-382 Summary: If the RRC file name begins with xml, an error is thrown while
generating the Java implementation.

Workaround: None

RSBT-371 Summary: When a context parameter is added or edited, the following message
is displayed at the promoted reference:
Regenerated context parameter mappings

When you click the message, the mappings are created but the error message
does not disappear.

Workaround: Clean the project.

RSBT-368 Summary: In the RRC file, if an operation name begins with a '/', an exception is
thrown.

Workaround: None

RSBT-363 Summary: While creating a REST binding on a promoted service, clicking Next
does not result in any action.

Workaround: Click Finish.
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RSBT-358 Summary: The following data types in a generated XSD do not match the data
types in the JSON payload:

1. unsignedByte mapped to short

2. nonpositiveinteger mapped to float

3. nonnegativeinteger mapped to float

4. unsignedshort mapped to int

5. gYear mapped to short

6. negativeinteger mapped to float

7. unsignedlong mapped to float

8. positiveinteger mapped to float

9. boolean mapped to string

Workaround: Edit the XSD file manually to reflect the correct datatypes.

RSBT-346 Summary: Error messages for duplicate resource names or operation names are
not displayed immediately when configuring a REST resource configuration
(.rrc) file. Similarly, the error message does not go away automatically when the
duplicate resource names or operation names are removed.

Workaround: Perform a clean operation.

RSBT-231 Summary: While adding a binding, when the pass through mode is enabled, a
note or warning indicating that any existing WSDL on the component reference
is replaced by the pass through WSDL is not displayed.

Workaround: None

RSBT-230 Summary: The HTTP Client textbox is not cleaned up after the resource
template is deleted from the Resource Templates folder.

Workaround: None

RSBT-58 Summary: If you upload a DAA that includes a REST binding, ActiveMatrix
Administrator does not check whether HTTP connector resource instances exist
for HTTP connectors defined for the REST binding. Later, when you attempt to
deploy this DAA, the deployment fails because of the missing resource instance.

Workaround: Create an HTTP connector resource instance in the ActiveMatrix
Administrator GUI. While configuring the REST binding in TIBCO Business
Studio, the name of the resource instance must match the user-specified HTTP
connector name.

SDS-7799 Summary: While generating a CLI script, if you add a new server, a Null
Pointer Exception is thrown.

Workaround: After adding a new server, click on the Refresh button.

SDS-7796 Summary: When an application with a SSL-enabled HTTP connector tries to
connect to a deployment server, the connection fails.

Workaround: None
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SDS-7781 Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, WS_Samples of 2.x result in
implementation errors.

Workaround: None

SDS-7780 Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, DAA generation fails for the
EmployeeVacation (2.x) Sample project.

Workaround: None

SDS-7779 Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, SoapException 2.x sample project
results in implementation errors.

Workaround: None

SDS-7776 Summary: After importing a 3.1.5 or 3.2.0 Java sample project in 3.4.0 TIBCO
Business Studio, the following error is displayed:
JAR file incompatible with JRE/JDK 1.7 due to containing entries 
with the empty name.

Workaround:

1. Open the Problems view.

2. Look for instances of the following error message:
JAR file incompatible with JRE/JDK 1.7 due to containing
entries with empty name. 

One such message is generated for each offending JAR file.

3. Right-click all these messages and select a quick fix to apply.

SDS-7763 Summary: When you launch TIBCO Business Studio in a new workspace and
click Help > Search for the first time, a NullPointer exception is returned.

Workaround: None

SDS-7729 Summary: While running Ant files in TIBCO Business Studio, the following error
is returned :
Launching <projectName><ant.deployment-build.xml' has encountered 
a problem,  
Launch configuration <projectName><ant.deployment-build.xml 
references non-existing project <projectName>

This is because of a bug in the Eclipse platform 4.7.1a (https://bugs.eclipse.org/
bugs/show_bug.cgi?id=522581).

Workaround: Run the Ant file using the Run in the same JRE as the workspace
option in the Create, manage, and run configurations dialog box. Alternatively,
change the project containing the build.xml to a Java project by adding
<nature>org.eclipse.jdt.core.javanature</nature> to the list of
<natures> in the .project file and then restart Eclipse.
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SDS-7725 Summary: If the 3.4.0 TIBCO Business Studio is used to load a workspace that
was created using 3.3.0 TIBCO Business Studio, running RAD (Rapid
Application Deployment) fails with the following error because the 3.3.0
workspace contains JRE 1.7 information:
Unsupported minor version

Workaround: Change the workspace JRE to Java 1.8.

SDS-7685 Summary: If a Java project uses the Java 8 specific syntax in the code, the DAA
file cannot be generated with execution environment as JavaSE-1.8. However,
Java 8 syntax and compilation is supported.

Workaround: To generate the DAA file with Java 8 code, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This
allows you to create the DAA and deploy it at runtime.

● For a newly created project, the RequiredExecutionEnvironment field in the
Manifest.MF file is empty.

● For an existing project, if Java 8 specific code is added, remove the
RequiredExecutionEnvironment entry in the Manifest.MF file.

SDS-7680 Summary: For a Custom Mediation task, generation of the DAA fails.
Workaround: While creating the Custom Mediation task, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This
allows you to create the DAA and deploy it at runtime.

SDS-7669 Summary: In the ActiveMatrix Administrator CLI, upgrading the existing
application did not update the Contact and Description fields in DAA.

Workaround: In the SystemNode.tra file, set the following property:
java.property.com.tibco.amx.admin.application.update.description.c
ontact.during.upgrade=true

SDS-7640 Summary: When an existing project is imported into a workspace and Java 8
code is added to it, the following error is returned while creating the DAA:
Exporting bundles failed

Workaround: To generate the DAA file with Java 8 code, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This
allows you to create the DAA and deploy it at runtime.
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SDS-6729,

SDS-6992
Summary: ActiveMatrix projects created in versions prior to 3.2.0 that use Java,
Spring or WebApp components encounter an Null Pointer Exception (NPE)
dialog when imported into any ActiveMatrix version running on JRE 1.7 or later.
This is caused by the incompatibility of JRE 1.7 with the JAR format of the
DataBinding JARs generated by ActiveMatrix versions prior to 3.3.0. This may
happen if you have upgraded to JRE 1.7 or installed an ActiveMatrix version that
includes JRE 1.7, such as version 3.3.0.

Workaround:

1. Open the Problems view.

2. Look for instances of the following error message:
JAR file incompatible with JRE/JDK 1.7 due to containing
entries with empty name.

One such message is generated for each offending JAR file.

3. Right-click on one of these messages and select a quick fix to apply. There are
three quick fixes available (all three back up old JARs):

● Fix JAR for JRE/JDK 1.7 compatibility-This option fixes only the selected
JAR (that is, the JAR you clicked to apply the quick fix).

● Fix all library JARs in project for JRE/JDK 1.7 compatibility-This option
fixes all of the offending JARs in the same project as the selected JAR
(that is, the JAR you clicked to apply the quick fix).

● Fix all library JARs in workspace for JRE/JDK 1.7 compatibility-This
option fixes all of the offending JARs in the workspace.

4. After applying a quick fix, some errors related to the component class may
still be seen. To clean up these errors, select the project that has the errors and
select Project > Clean.

SDS-6264 Summary: If the Web Application component is added by right clicking on the
composite, the Generate Servlet Implementation option is not available under the
Quick Fixes option.

Workaround: Select the Web Application component, right-click, and select
Generate Servlet Implementation.

SDS-5866 Summary: When one of the nodes participating in a high availability
configuration is stopped and an application is deployed via TIBCO Business
Studio, the deployment never completes.

Workaround: Deploy the application from ActiveMatrix Administrator. The
application state is in a partially running state instead of running - which is the
expected behavior.

SDS-3890 Summary: Sometimes, the following message is returned in the error log:
Unbanded EventLoop Exception

Workaround: None. Ignore the error.
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SVCP-84 Summary: The TIBCO ActiveMatrix Service Performance probe on the
Administrator node does not receive self-shutdown notifications sent from
TibcoHost. This occurs because the Service Performance Manager probe
component on the Administrator node responsible for such communication
shuts down before it can send the notification.

Workaround: None

TAP-16041 Summary: In the deploy-application target of application_build.xml file, if
the force attribute is set to true, then application deployment is successful even
if the required resource instance is not available. This issue is applicable if the
resource instance required for an application is defined in the policy set.

Workaround: When deploying an application, set the force attribute to false in
the deploy-application target of application_build.xml file. Setting the
force attribute to false checks for all dependencies required by an Application.

TAP-15885 Summary: Accessing ActiveMatrix Administrator Dashboards ( Dashboard >
Infrastructure) results in the following error:
Dashboard Bundle not Available. Please reload the browser. 
TypeError: Cannot read
property 'Container' of undefined

Workaround: Access ActiveMatrix Administrator Dashboards using the
procedure mentioned in "Accessing Administrator Dashboards" section of the
TIBCO ActiveMatrix Service Grid Administration guide.

TAP-15863 Summary : On Microsoft Windows, when HSQLDB is used and the Log Service
is enabled, the following error is intermittently seen in the CONFIG_HOME
\tibcohost\<instance_name>\data_3.2.x\nodes\SystemNode\logs

\SystemNode.log of the ActiveMatrix enterprise:
TIBCO-AMX-HPA-014016: Uncaught exception in thread Thread 
[LoggingThread,5,Job_Executor]
java.lang.IllegalStateException: No uri

After this error is seen, Governance > Log Viewer (logservice) does not work
from the ActiveMatrix Administrator UI and the following error is returned:
Loading log service list failed. You have no permission to visit 
logviewer or the log service admin plugin is not available.

Workaround : None

TAP-15842 Summary: If you create an enterprise that uses a messaging bus and then create
an environment that does not use the messaging bus, the Configure enterprise
without a messaging bus check box on the Admin Configuration > General tab
is disabled.

Workaround: None

TAP-15834 Summary: When using the Microsoft Edge browser, when creating an Object
Group of Policy Director Governance by specifying the search criteria to find the
matched group members, if you click the + button to build the search criteria, the
attribute and operator drop-downs are not populated with the correct values.

Workaround: None
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TAP-15833 Summary: When using the Microsoft Edge browser, when building the search
criteria to find the matched group members, the X button does not clear the
drop-down boxes used to specify the search criteria.

Workaround: None

TAP-15827 Summary: If you have upgraded to ActiveMatrix 3.4.0, and then created a new
Host or Node, some default loggers are missing on the newly created Host or
Node.

Workaround: Before creating the new Host, copy the
DefaultLogConfiguration.properties file on every TibcoHost instance on
which the ActiveMatrix Administrator server is running.

Copy the file from <TIBCO_HOME>\administrator\3.4\templates\ and paste it
into <CONFIG_HOME>\admin\amxadmin\private\<instanceName>\.

TAP-15822 Summary: You cannot deploy an ActiveMatrix 3.4.0 DAA on ActiveMatrix 3.3.1
Administrator, ActiveMatrix 3.3.0 Administrator or ActiveMatrix 3.3.0 Hotfix 23
Administrator that uses Java 8.

Workaround: None

TAP-15817 Summary: When using the Microsoft Edge browser on Windows 10, the Metrics
Collection Runtime dashboard is not displayed.

Workaround: None

TAP-15664 Summary: On Solaris Sparc, Get Admin Information use test of Enterprise
Deployment Health Check fails with the following error:
Couldn't obtain phys addr

Workaround: None
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TAP-15645 Summary: When a TIBCO ActiveMatrix enterprise has customized system host
and system node names (for example: SystemNode1, SystemNode2, or
AdminNode) and the system node does not fully start in a TIBCO ActiveMatrix
enterprise, the following error message is displayed on the TIBCO ActiveMatrix
Administrator web page:
404 page not found

Prior to TIBCO ActiveMatrix 3.3.0 Hotfix 13, when a user tried to
access a TIBCO ActiveMatrix Administrator web page while it is still
loading or the user specified a wrong URL (correct with respect to IP
address and port number), a "404 page not found" HTTP error
response was returned. Starting with TIBCO ActiveMatrix 3.3.0 Hotfix
13, in the same situation, a new 404 page is displayed. This new 404
page automatically redirects the user to the login page once TIBCO
ActiveMatrix Administrator is fully initialized and ready for service.
However, this feature applies only to environments where the System
Nodes use the default node names, that is, SystemNode and
SystemNodeReplica. For System Nodes with customized node names,
the old behavior ("404 page not found" error page) remains.

Workaround: Periodically, refresh the ActiveMatrix Administrator web page to
determine whether ActiveMatrix Administrator was completely initialized and is
ready for service.

TAP-15563 Summary: After upgrading ActiveMatrix Administrator from 3.1.5 to 3.4.0, you
can start or stop a host from the ActiveMatrix Administrator GUI. However, 3.1.5
hosts that are not upgraded yet, cannot be started or stopped from the
ActiveMatrix Administrator GUI.

Workaround: Start or stop the host by using the tibcohost command.

TAP-15523 Summary: TIBCO ActiveMatrix Administrator > Infrastructure > Health Check
page does not open in Internet Explorer. However, it displays a link to open the
page in a new tab.

Workaround: Open http://localhost:8120/amxadministrator/
amxmonitor.jsp in a new tab to view the Health Check page.

TAP-15503 Summary: In the Google Chrome browser, when creating an Object Group of
Policy Director Governance by specifying the search criteria to find the matched
group members, if you click the + button to build the criteria, the attribute drop-
down box is not populated with the correct values.

Workaround: None

TAP-15488 Summary: In TIBCO ActiveMatrix Administrator, some description fields do not
work with Chrome 66.0.3359.139 or higher versions.

Workaround: None
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TAP-15420 Summary: In TIBCO ActiveMatrix Administrator, when you navigate to
Infrastructure > Enterprise Status > Application tab and click Download Logs,
the requested application logs are not downloaded and the following error is
displayed:
Cause: java.util.concurrent.TimeoutException.

Workaround: None

TAP-15060 Summary: After successfully downgrading to a previous version, you must
uninstall the higher version.

Workaround: None

TAP-14874 Summary: After reconnecting to EMS, ActiveMatrix Administrator shows the
correct status but the Action History continues to show "In Progress(n)".

Workaround: None

TAP-14772 Summary: Even when the Notification transport update was completed
successfully using the ActiveMatrix Administrator CLI, the following error
message was displayed:
TIBCO-AMX-ADMIN-021085: Failed to update the notification 
transport!, Caused by:
TIBCO-AMX-ADMIN-021281: The number of hosts in this enterprise is 
more than 10. 
Please use the Administrator Command Line Interface for updating 
the Notification Transport. 

Workaround: None

TAP-14766 Summary: Ideally, in TIBCO ActiveMatrix, you should update the Notification
Transport for all TIBCOHosts in the enterprise. If a particular TIBCOHost has to
be updated using the hosts option from ActiveMatrix Administrator CLI, you
must update the SystemHost's Notification Transport first, and then proceed
with updating the Notification Transport for other TIBCOHosts.

If SystemHost is not updated first, while updating Remote TIBCOHosts,
ActiveMatrix Administrator CLI might show the update as having been
completed successfully, but the TIBCOHosts might not actually be updated.

Workaround: Update the Notification Transport for the SystemHost first.

TAP-14699 Summary: When the Java property
java.property.com.tibco.amx.decouple.Manual.Nodes is not set to true in
the tibcohost.tra file, the status of a Manual Node is marked as Stopped even
when it is Running (Node process remains in task manager).

Workaround: None

TAP-14242 Summary: When you log in to ActiveMatrix Administrator server using SSL-
enabled LDAP authentication realm, returns a non-fatal
ClassNotFoundException in the SystemNode log.

Workaround: None
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TAP-14052 Summary: The uninstall action does not work as expected with a wildcard if the
given feature versions have strict (1.0.0) and qualified strict (1.0.0.01) versions
together.

In a wildcard behavior, the following behavior is observed:

If the user has two versions for the same featureId in the form of 1.0.0 (Strict
version without qualifier) and 1.0.0.001 (Strict version with qualifier), precedence
is given to 1.0.0.001 only and 1.0.0 is not uninstalled.

Workaround: To uninstall 1.0.0 explicitly, perform the same action again.

TAP-13994 Summary: The Hostname in the Management URL of a TibcoHost instance gets
replaced with the Hostname of its source TibcoHost, when TibcoHost Instance is
installed successfully.

Workaround: None

TAP-13942 Summary: On the <Host> -> <ResourceInstance> page and Shared Objects ->
Resource Templates -> Resource Instances tab, environment or duplicate node
information is not displayed.

Workaround: On the Details pane of <Host> -> <ResourceInstance> page and
Shared Objects > Resource Templates > Resource Instances tab, navigate to the
tree view in the left side pane. This tree view provides the exact node name:
<Environment Name>_<node name>.

TAP-13910 Summary: While exporting Logging Appenders, one logging appender
<CustomName>_Root is exported when the following conditions are met:

● host name of the replicated admin server is changed from the default
SystemHostReplica to a custom name.

● Include System Objects option is NOT selected.

Workaround: None

TAP-13828 Summary: When installing or uninstalling a node, the most recent state of the
node is displayed in the Action History column and not in the Node State
column. For example, after uninstalling a node, the Node State is Not Installed
while the action is in progress. This happens when there are incomplete tasks for
an action but the node state has already changed.

Workaround Refer to the most recent state displayed in the Action History
column instead of the Node State column.

TAP-13777 Summary: If the TibcoHost name in the ActiveMatrix Administrator GUI and
run time is different and the TibcoHost name from the ActiveMatrix
Administrator GUI is specified in the CLI data, the install/start/uninstall actions
fail.

Workaround: None

TAP-13696 Summary: If a Management URL is unreachable and you try to unregister the
TibcoHost, a warning message about the unreachable URL is not displayed.

Workaround: None
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TAP-12878 Summary: If you import a resource template into an upgraded user application
that did not previously contain a resource template (that is, if no resource
templates had previously been imported into the application), the scope of the
imported resource template is automatically set to Global, rather than
Application. This occurs even if you specify Application scope in the CLI.

Workaround: After the resource template is imported (to Global scope), change
its scope as required (to Application scope, for example) in the ActiveMatrix
Administrator UI. To do this:

1. Go to Shared Objects > Resource Templates.

2. Select the imported resource template.

3. Click Change Scope, and change the scope to the Application or
Environment level as required.

TAP-12860 Summary: If you have a main process and a subprocess application and one or
more dependent main process applications deployed in ActiveMatrix version
3.1.5 (and any ActiveMatrix BPM version between 1.3.0 and 2.1.0), then upgrade
the BPM platform version to ActiveMatrix BPM 2.2.0 (ActiveMatrix 3.3.0), and
subsequently attempt to upgrade the subprocess, you will see a warning similar
to the following example:
TIBCO-AMX-ADMIN-012430: Provided capability 
'com.example.my.subprocess.pe.capability' provided by component 
'MySubAppProcessFlow' cannot be removed. It is being used by the 
following components:Component 'MyMainAppProcessFlow' from 
application 'com.example.my.mainapp.process

This warning is issued erroneously and can be safely ignored. The subprocess is
upgraded successfully and the main processes runs as expected, provided the
subprocess maintains the same major version number as before.

Workaround: None
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TAP-12858 Summary: The logging configuration of a node, host, or application (which is
stored in the node, host, or application’s log4j.xml; for example, node-
log4j.xml) might enter into an inconsistent state if the node, host, or application
uses a JMS appender that is configured with an SSL-enabled EMS server. In this
case, the logging configuration uses an HTTP URL to refer to a keystore that’s
hosted on the Administrator. This HTTP URL is the internal HTTP connector
URL of the Administrator.

Changing the configuration of the internal HTTP connector (for example, to
enable SSL or change the port number) causes the URL configured in the logging
configuration (log4j.xml) to become invalid or out of synch. The logging
configuration of each affected node, host, or application needs to be updated or it
will fail to connect to EMS. Currently this is not done automatically.

Workaround: You must manually save and apply the logging configuration for
each node, host, or application that uses a JMS appender. To do this:

1. In the ActiveMatrix Administrator UI, go to the logging configuration for the
node, host, or application that is in the situation described above.

2. Change a value in the logging configuration that makes the node, host, or
application go out of sync.

3. Click Save.

4. Click Apply. This pushes the new logging configuration, with a new HTTP
URL, to the node, host, or application.

TAP-12738 Summary: If you delete a binding using the ActiveMatrix Administrator UI, that
binding is still visible in the SPM dashboard with a Down status. This occurs
because the Delete notification for the ActiveMatrix binding component is not
being emitted.

Workaround: None

TAP-12714 Summary: ActiveMatrix Administrator does not properly undeploy applications
with missing feature dependencies.

Workaround: To avoid this issue, go to Node > Configuration > Features and
remove the feature with Marked for Install and a blank value for Type. You
should be able to undeploy the application with no issues.

TAP-12702 Summary: If you use TIBCO Configuration Tool to edit the ActiveMatrix
Administrator database settings, the following harmless error might appear in
SystemNode.log:
Could not open Hibernate Session for transaction. 

Workaround: None
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TAP-12319 Summary: When deploying an application, ActiveMatrix Administrator
automatically installs resource instances if there are resource templates with
scope to the application. If the resource template installation fails, then
application deployment also fails. For example, if the HTTP connector has a port
conflict, it fails to start.

Workaround: For HTTP connector port conflicts use substitution variables to
assign different port numbers for each node to avoid port conflicts. Then,
uninstall the application and redeploy it.

TAP-12087 Summary: Making changes to the configuration of a JDBC service resource
template that is a dependency for a running application might cause that
application to enter a Stopped state.

Workaround: Manually restart the stopped application.

TAP-10830 Summary: When wiring a reference to a service in the same application that has
a SOAP binding using an HTTP Connector that does not exist results in the
following exception:
Error generating the WSDL for binding SOAPService_Binding1, 
Caused by: Could not find resource instance with name 
httpConnector when generating WSDL for binding 
SOAPService_Binding1 on service NewService

Workaround: Create the HTTP connector before creating the application.

TAP-10800 Summary: When creating an Administrator server with an Oracle database the
following error messages are seen in the SystemNode log files:
SystemNode 30 Jul 2012 16:42:48,287 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create 
index AdmnCnfig_sttsNtifictinTrnsprt on "ADMINCONFIG" 
("NTFCTNTRNSPRT_STTSNTFCTNTRNS_D")
SystemNode 30 Jul 2012 16:42:48,287 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-00955: name is 
already used by an existing object
SystemNode 30 Jul 2012 16:42:48,303 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create 
index AMXdminsrPrfrncs_prvisnvslctin on "AMXADMINUSERPREFERENCES" 
("PRVISNVSLCTIN_PRVISNVSLCTIN_ID")
SystemNode 30 Jul 2012 16:42:48,303 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-00955: name is 
already used by an existing object
SystemNode 30 Jul 2012 16:42:48,319 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create 
index ApplicationFolder_childFolders on "APPLICATIONFOLDER" 
("APPLICATIONFOLDER_PARENT_E_ID")
SystemNode 30 Jul 2012 16:42:48,319 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-01408: such column 
list already indexed

Workaround: These errors can be safely ignored as the indexes are created.

77

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

TAP-10767 Summary: HTTP Connector resource instances that are referenced by properties
whose names are not specific, such as HttpInboundConnectionConfig or
httpConnector, are not recognized by Administrator as HTTP Connectors while
displaying information. As a result these HTTP Connectors are not displayed in
the Administrator UI as dependencies where expected.

Also, you can delete any such HTTP Connector even when it has dependent
applications.

Workaround: Use property names such as HttpInboundConnectionConfig or
httpConnect to refer to HTTP Connectors resource instances. Additionally when
deleting a HTTP Connector resource instances manually check whether other
applications are dependent on it.

TAP-10751 Summary: Executing the scripts generated by the DDL Script Generator for
Microsoft SQL Server displays errors reporting a failure to create foreign key
constraints.

Also, even if the generated scripts are not used, error messages are seen in the
SystemNode log file logged in SystemNode.log regarding failure to create
foreign key constraints.

Workaround: None. These errors can be ignored as a failure to create foreign key
constraints does not impact product functionality.

TAP-10663 Summary: Heterogeneous environments with mixed JREs are not supported.
Sun JRE is not compatible with IBM JRE when it comes to storing secret keys in a
Java keystore. This causes a problem when the server running on Sun JRE stores
a username and password in its global identity keystore and a host and node
running on IBM JRE attempts to access that username and password. The
reverse, Administrator JRE would have the same problem.

Workaround: Ensure that, TibcoHost instances, and nodes are all using JREs
provided by the same vendor.

TAP-7644 Summary: You might see the following error message when undeploying an
application:
[ERROR] com.tibco.amf.admin.server.axis2.RPCMessageReceiver -
Error occurred in Administrator... about to throw AxisFault for 
this exception 

Workaround: Refresh the browser. This error message can be safely ignored.

TAP-7571 Summary: Users who have permissions only to view an application and an
environment but do not have permissions to view a node are not able to see the
list of selected nodes when distributing an application.

Workaround: Permissions to view the node have to be explicitly granted by a
superuser.

TAP-7423 Summary: You might see errors in dashboard dialog box when using the
Dashboard.

Workaround: Click OK to proceed using the Dashboard. This error message can
be safely ignored.
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TAP-6584 Summary: When the extended monitoring is enabled the two new periodic
windows (24 hours and 7 days) do not show on some Dashboard tabs.

Workaround: Refresh the browser.

TAP-5653 Summary: Updating the value of a substitution variable for the Timeout
property in a JMS or SOAP/JMS binding in a deployed application does not take
effect after the application is redeployed.

Workaround: Undeploy and deploy the application.

TAP-4890 Summary: In the dashboards, a text filter is ignored when you maximize or
minimize a gadget.

Workaround: Re-enter the text filter.

TAP-4645 Summary: On the Dashboards > Infrastructure screens, resource instances
cannot be filtered by promoted reference or promoted service.

Workaround: In the Application Screen, check properties of the reference or
service bindings.

WSBT-1149 Summary: Web service reliable messaging does not work in TIBCO ActiveMatrix
Service Grid 3.4.0.

Workaround: None

WSBT-1134 Summary: In case of SOAP bindings, context parameters of Type "Message" can
be defined using "Message/Part" from the WSDL used by the binding. These
message context parameters can be used for declared unbound SOAP headers.
The body of a SOAP message is also defined using "Message/Part"
configuration from the WSDL used by the binding. Using the same "Message/
Part" configuration for the SOAP header and the SOAP body results in incorrect
behavior while generating the SOAP message, that is, either the <Header> or the
<Body> element might be empty. This applies to SOAP request, SOAP response
and SOAP fault messages.

For example, if the body of the SOAP response is configured with
Message="GetSOAPResponse"/Part = "param1" in the WSDL and the context
parameter of Type "Message" is defined with the same Message/Part Definition
"GetSOAPResponse/param1", the generated SOAP response message might
contain empty <Header> or <Body> element.

Workaround: None However, if distinct "Message/Part" pair are used for SOAP
header and body, this issue does not occur. For example, if the body of the SOAP
response is configured with Message="GetSOAPResponse"/Part = "param1" in
the WSDL and the context parameter of Type "Message" is defined with
Message/Part Definition "GetSOAPHeader/headerparam1", the generated
SOAP response message contains both <Header> and <Body> elements.

WSBT-1112,

WSBT-1117

Summary: For SOAP bindings containing all in-only operations, the Enable
Response Message Validation field in ActiveMatrix Administrator and TIBCO
Business Studio is not applicable.

Workaround: At present, this field is not disabled for SOAP bindings containing
all in-only operations and, if selected, does not have any effect.
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WSBT-888 Summary: Substitution Variables are not available for all the fields in SOAP
Service and Reference Bindings. On the Service side, Substitution Variables are
supported for the following fields:

● Enable Request Message Validation

● Enable Response Message Validation

● Sender Identified Expression

On the Reference side, Substitution Variables are supported for the following
fields:

● Enable Request Message Validation

● Enable Response Message Validation

● Filespec of Endpoint URL

Workaround: None

WSBT-881 Summary: Policies and policy sets cannot be added, edited, or deleted via the
ActiveMatrix Administrator UI. Policy set properties can be viewed but not
added, edited, or deleted.

Workaround: Edit policy sets and properties in TIBCO Business Studio.

XPD-5331 Summary: Deploying DAAs or applications with the following characteristics in
ActiveMatrix BPM 2.2.0 runtime might result in a No request message is
found to add the username token error at runtime:

● The DAA or application was created in TIBCO Business Studio prior to
version 3.6.0.

● The DAA or application contains a Web Service invocation (that is, the
application is a consumer)

● The application has a UsernameToken policy type in its security

Workaround: Open the project in TIBCO Business Studio 3.6.0, build the DAA,
and upgrade the existing application.

XPD-1858 Summary: When opening a native file browse dialog on RedHat Linux for the
first time, can crash.

Workaround: Type the path to the file in the text control.
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